Lifelines iEEG Portable

& Acquire Touch Variants

User Manual

Revision 2.00

Software Version 2.1
Regulatory Compliance

K143487: FDA 510(k) Clearance for class II medical device.

Product: Lifelines iEEG

Copyright

All rights reserved. This manual contains proprietary information which is protected by copyright and may not be copied in whole or in part except with the prior written permission of Kvikna and Kvikna Medical. The copyright and the foregoing restrictions on the copyright use extend to all media in which this information may be preserved.

This copy of the Lifelines iEEG User Manual shall be used only in accordance with the condition of sale of Kvikna and Kvikna Medical or their distributors.

Kvikna and Kvikna Medical make no representations or warranties of any kind whatsoever with respect to this document. Kvikna and Kvikna Medical disclaim all liabilities for loss or damage arising out of the possession, sale or use of this document.

Kvikna® is a registered trademark of Kvikna ehf.
Lifelines iEEG® is a registered trademark of Kvikna ehf.
Lifelines® is a registered trademark of Lifelines ltd.
Microsoft Word®, Windows®, and Office® are registered trademarks of Microsoft Corporation.
All other trademarks and product names are the property of their relevant owners.

Kvikna and Kvikna Medical
Stórhöfði 21
110 Reykjavik
Iceland
Tel: +354 578 8400
Email: kvikna@kvikna.com
www.kvikna.com

Report suggestions or complaints by email: ieeeg@kvikna.com
Lifelines iEEG Portable User Manual  Revision 2.0

Locked Patient Mode ........................................................................................................64
End the Recording ..............................................................................................................66
Manual Transfer of Exam .................................................................................................66
Lifelines iEEG Review ....................................................................................................67
Launch iEEG Review .......................................................................................................67
Exam Mode .......................................................................................................................67
Review ...............................................................................................................................68
Channel Chart ..................................................................................................................69
Event Palette ....................................................................................................................77
Panel .................................................................................................................................81
Menu .................................................................................................................................87
Settings .............................................................................................................................88
Settings..............................................................................................................................89
Montage ..............................................................................................................................89
Events .................................................................................................................................99
Perspectives .....................................................................................................................102
My Settings ......................................................................................................................105
Acquisition .......................................................................................................................107
Appendix: Manufacturer’s Declaration ........................................................................107
Trackit Mk3 .........................................................................................................................108
WiEEG Model 100 ...........................................................................................................112

Intro

Intended Use

Lifelines iEEG is an EEG system that allows acquisition, display, archive, storage and analysis of physiological signals. The intended user of this product is a qualified medical practitioner trained in electroencephalography who will exercise professional judgment in using the information.

The Lifelines iEEG system also includes the display of quantitative EEG plots, power spectrum, which is intended to help the user to monitor and analyze the EEG.
This device does not provide any diagnostic conclusion about the patient’s condition to the user.

Caution: Federal (USA) law restricts this device to sale by or on the order of a physician licensed by the law of the State in which he practices to use or order the use of the device.

**Indication for Use**

Lifelines iEEG is used an aid in the diagnosis of neurophysiological disorders such as epilepsy.

**Disclaimers and Warranties**

The information in this section is subject to change without notice.

Except as stated below, Kvikna ehf (Kvikna) makes no warranty of any kind with regard to this equipment, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose. Kvikna shall not be liable for errors contained herein or for incidental or consequential damages in connection with the furnishing, performance or use of this equipment.

Misuse, accident, modification, operating environment, improper maintenance or damage caused by a product for which Kvikna is not responsible will void the warranty.

Kvikna does not warrant uninterrupted or error-free operation of its products.

Kvikna or its authorized agents will repair or replace any products which prove to be defective during the warranty period, provided that these products are used as prescribed in the operating instructions in the user’s and service manuals.

No other party is authorized to make any warranty to assume liability for Kvikna’s products. Kvikna will not recognize any other warranty, either implied or in writing. In addition, services performed by someone other than Kvikna or its authorized agents or any technical modification or changes of products without Kvikna’s prior written consent may be cause for invalidating this warranty.

Kvikna manufactures hardware and software to be used on or with standard PC-compatible computers and operating software. Kvikna, however, assumes no responsibility for the use or reliability of its software or hardware with equipment that is not furnished by third-party manufacturers accepted by Kvikna at the date of purchase.

All warranties for third-party products used within the Lifelines iEEG system are the responsibility of the relevant manufacturer. Please refer to the relevant documentation on each product for further details.

This document contains proprietary information that is protected by copyright. All rights are reserved. No part of this document may be photocopied, reproduced in any other form or translated into another language without the prior written consent of Kvikna.

**Compliance**

The system is designed to comply with the following medical safety standards.
**International standards:**

- IEC 62366:2007  Medical devices -- Application of usability engineering to medical devices

**European standards:**

- EN ISO 14971:2012  Medical devices – Application of risk management to medical devices.
Safety and Warning Notices

Warnings are directions which, if they are not followed, can cause fatal or serious injuries to a user, engineer, patient or any other person or can lead to a mistreatment.

**WARNING:** Safety of Lifelines iEEG systems cannot be ensured unless all components are provided by Kvikna ehf or an authorized agent. Items not specified as part of a Lifelines iEEG system must not be connected to a Lifelines iEEG system.

**WARNING:** Lifelines iEEG is intended to be installed, used and operated only in accordance with the procedures given within this manual and accompanying documentation for the purpose for which it was designed. Nothing stated in this manual reduces the user’s professional responsibilities for sound judgment and best practice.

**WARNING:** Users shall only install, use and operate the equipment in such ways that do not conflict with applicable laws or regulations which have the force of law.

**WARNING:** Use of the equipment for purposes other than those intended and expressly stated by the manufacturer, as well as incorrect use or operation, may relieve the manufacturer or his agent from all or some of the responsibility for resultant non-compliance, damage or injury.

**WARNING:** This equipment is intended to be used by a healthcare professional.

**WARNING:** This equipment is intended only as an adjunct device in patient assessment; it must be used in conjunction with other methods of patient diagnosis. This equipment is not to be used for the determination of brain death.

**WARNING:** The Lifelines iEEG system is not intended to be used as a vital signs monitor.

**WARNING:** Lifelines does not supply the Nonin sensor. Only use the ‘PureLight’ sensors specified by Nonin to be used with their Oximeters.

**WARNING:** The function or safety of the equipment could be impaired if it has been subjected to unfavorable conditions in storage or in transit. If at any time function or safety is thought to be impaired, the instrument should be taken out of operation and secured against unintended use.

**WARNING:** Do not open or modify the equipment without the authorization of the manufacturer. Unauthorized modification may result in injury.

**CAUTION:** Do not touch simultaneously any accessible USB or other contacts on the PC or monitor and the patient.

**WARNING:** Lifelines iEEG may cause radio interference or may disrupt the operation of nearby equipment. It may be necessary to take mitigation measures, such as re-orienting or relocating the Lifelines iEEG system or shielding the location.
**WARNING:** The use of accessories, transducers and cables other than those specified, with the exception of transducers and cables sold by Kvikna ehf or an authorized agent as replacement parts for internal components, may result in increased emissions or decreased immunity of the Lifelines EEG system.

**WARNING:** Care should be taken in using systems with photic stimulator. The operator should not look into the photic device when it is turned on. When the photic stimulator is not in active use, it should not face anyone.

**CAUTION:** None of the equipment or packaged components in the devices is sterile. They should not be used in a sterile environment.

**WARNING:** Use only medical grade power supplies. These are provided with the system.

### Additional Warnings Specific to Laptop and Tablet PC Systems

The following warnings, in addition to the other warnings in this chapter, must be heeded regarding the installation and use of the all laptop and tablet pc systems.

**WARNING:** All software components are supplied configured. The power options settings (in the Control Panel) must not be changed or tampered with.

**WARNING:** Do not place laptop or tablet pc on a soft surface, e.g. a couch or blanket. This can cause overheating and the system may shut down.

**WARNING:** Strangulation hazard due to long cables. Keep cables away from doorways and walkways and keep out of reach of children.

**WARNING:** Choking hazard. Contains small parts that may cause choking if swallowed. Keep out of reach of children.

### Additional Warnings Specific to System 1040 WiEEG

The following warnings, in addition to the other warnings in this chapter, must be heeded regarding the installation and use of the 1040 WiEEG variant.

**WARNING:** The WiEEG amplifier must never be attached to a patient during the battery charge cycle. This could cause electrical burns to the patient.

**CAUTION:** The WiEEG amplifier must be turned off during the charge cycle.

**WARNING:** Review all Safety Information before connecting the BraiNet® WiEEG to a patient.

**WARNING:** Only individuals trained in the operation of the WiEEG recorder should connect a patient to the WiEEG recorder.
CAUTION: The WiEEG Transmitter Module must be fully charged prior to each EEG recording. 12 hours is recommended time for a full charge.

EEG Electrodes

The Trackit Mk3 amplifier connects to standard 1.5mm touch proof electrodes using DIN 42802-style connectors arranged in a standard 10-20 pattern, attached to the patient’s head.

The WiEEG model 100 amplifier uses Ives EEG electrodes and a BraiNet® Kit. See the accompanying documentation for more information.

WARNING: Lifelines does not supply EEG electrodes. To ensure patient safety, the electrodes used must be approved to the Medical Device Directive 93/42/EEC in Europe or to the relevant local standards outside Europe.

CAUTION: The conductive part of electrodes and their connectors, including the Neutral electrode, should not contact other conductive parts including earth.

WARNING: Electrode Placement: Caution should be taken when plugging electrodes into the EEG Amplifier to ensure that the correct socket is used for each electrode.

Use with other equipment

Defibrillators and HF surgical equipment

The equipment is not defibrillator proof and should not be used in situations where a defibrillator is likely to be used.

WARNING: The equipment should not be used with high frequency surgical equipment.

CONTRAINDICATIONS: Do not use the amplifier in an MRI environment. Failure to follow this warning may cause serious electrical burn on the patient due to local heating caused by dielectric electromotive force.

CONTRAINDICATIONS: Do not use the amplifier near a defibrillator. Before defibrillation, remove the WiEEG transmitter module from the patient. If the discharged energy from the paddles were to come into contact with the device or its transducers, it could give the patient an electrical burn.

WARNING: Do not use the amplifier in an explosive atmosphere due to risk of explosion.

Other patient-connected equipment

When used simultaneously with other patient-connected equipment, for example a cardiac pacemaker or other electrical stimulator, it is unlikely that a safety hazard will arise. However always consult the documentation supplied with the other patient-connected equipment to
ensure that all hazards, warnings and cautions are considered before the equipment is used together.

**WARNING:** Non-medical equipment, when used with the system, should comply with IEC/ISO safety standards relevant to that equipment. IT equipment should comply with IEC 60950.

**Leakage current**

This system is designed to comply with IEC 60601-1, the international standard for medical electronic equipment, which specifies the permissible levels of leakage current. A potential hazard exists in the summation of leakage currents caused by connecting several pieces of equipment together. Because this system can be used in conjunction with standard electronic devices, the total leakage current should be tested whenever the system is modified.

There should be no electrical connections between the system equipment, which is powered via the isolation transformer, and any other equipment powered from a non-isolated mains supply.

**Interference**

**WARNING:** The Trackit Mk3 and WiEEG will continue to operate in the presence of radio frequency magnetic fields (RF) and the effects of electrostatic discharges (ESD) and other interference, in accordance with the requirements of EN60601-1-2. However, the amplifiers record signals of very low amplitude, and these signals themselves are not immune to the effects of RF, ESD and low-frequency magnetic field interference. Such interference may cause signal artefacts and compromise the intended use of this device.

The Trackit Mk3 may have internal radios fitted. These are approved industry-standard Bluetooth and Wi-Fi types which present minimal risk of reciprocal interference with other equipment.

**WARNING:** When in close proximity to the amplifier, do not use mobile phones, transmitters, power transformers, motors, or other equipment that generates magnetic fields. Do not use the device near radio stations, high frequency cables, radio or television. Refer to the Appendix for more information.

**WARNING:** The equipment or system should not be used adjacent to or stacked with other equipment. If adjacent or stacked use is necessary, the equipment or system should be kept under observation to verify normal operation in the configuration in which it will be used.

**WARNING:** Medical electrical equipment needs special precautions regarding EMC and needs to be installed and put into service according to the EMC information provided in the Appendix.
Maintenance and Cleaning

The iEEG acquisition system contains no user-serviceable parts (apart from replaceable batteries of the Trackit recorder). The system uses solid-state components and requires no routine testing or maintenance procedures apart from occasional cleaning and checking for wear and damage to all parts including accessories. Replacement of individual system parts is done by qualified Lifelines iEEG distributors only.

Cleaning

The outer surfaces of the system may be cleaned using a soft cloth moistened with water and mild detergent. A low-pressure air-line or a vacuum cleaner can also be used.

It is recommended to clean the WiEEG amplifier between each patient application.

**CAUTION:** Do not allow any liquid to enter the case of any instrument or connector. Do not use acetone on any of the instruments.

Reusable electrodes are to be cleaned and disinfected according to the instructions provided by the respective manufacturer.

Disposal

Items marked with this symbol require special recycling. Do not dispose of in landfill. When this equipment has reached the end of its useful life, it must be disposed of in an environmentally-friendly way. Waste electrical and electronic equipment (WEEE) requires special procedures for recycling or disposal. This includes batteries, printed circuit boards, electronic components, wiring and other elements of electronic devices. Follow all of your respective local laws and regulations for the proper disposal of such equipment. Contact your local distributor for information concerning this.

The WiEEG units do not present any biological or radioactive threat and may be disposed of according to local regulations, or returned to the manufacturer for disposal.

The BraiNet® template is a single patient use disposable device and should be properly disposed of after use in accordance with your facilities procedures for such.

**CAUTION:** Do not dispose of batteries by incineration.

Environmental Parameters for Operation

The operational and storage/transportation environmental conditions are as follows:

**Operational:**

Temperature – Trackit Mk3  
+10°C to +40°C

Temperature – WiEEG  
+5°C to +35°C
Relative humidity – Trackit Mk3 25% to 95% non-condensing
Relative humidity – WiEEG 40% to 93% non-condensing
Atmospheric pressure - All 700mB to 1060mB

**WARNING:** Do not obstruct any cooling slots. Position the equipment so that air flows freely.

**Storage and Transport:**
- Temperature – Trackit Mk3 -10°C to +50°C
- Temperature – WiEEG -10°C to +45°C
- Relative humidity – Trackit Mk3 10% to 95% non-condensing
- Relative humidity – WiEEG 40% to 93% non-condensing
- Atmospheric pressure – Trackit Mk3 500mB to 1060mB
- Atmospheric pressure – WiEEG 700mB to 1060mB

**Third-party Devices**
Refer to all third-party device documentation and heed all warnings, cautions and safety markings associated with the installation and use of those devices before using this system.

**Reporting Incidents**
In the event of a malfunction or change in performance of the device that may affect safety, send a report to ieeg@kvikna.com

**Warning Symbols**

![Warning Symbol]

Additional warnings are indicated by this symbol elsewhere in this document.
Device Description

The Lifelines iEEG medical device is intended for acquisition and review of EEG and other physiological data as well as digital video synchronized to the EEG. It offers industry standard features such as re-montaging and band pass filtering. Furthermore it offers spectral analysis in the form of trend analysis and user selected sections of EEG.

The Lifelines iEEG acquisition system consists of the following:

- Proprietary software
- Off the shelf IT components
- Medical power supplies
- EEG amplifier

 Optionally:

- Photic Stimulator

The EEG amplifier is a medical device (Lifelines Trackit – FDA K010460 or JNS iEEG model 100 – FDA K131944) and the photic stimulator is as well (Lifelines Photic Stimulator – FDA K101691). The off the shelf IT components include a PC, for example a Laptop, a “power over Ethernet” switch, IP video cameras and cables. The PC and the switch are powered by medical power supplies. Cameras are powered through the switch.

The Lifelines iEEG acquisition software which is a part of the Lifelines iEEG software system allows the user to interact with the hardware, i.e. amplifier, photic stimulator and video cameras. Furthermore, it stores and presents the information collected by the hardware following industry standard, user customizable processing. Furthermore it allows the user to annotate the data during recording.

Lifelines iEEG is a software system also used to manage and review EEG examinations. It works on data acquired by the Lifelines iEEG acquisition software as well as data from some third party EEG equipment that is imported into the system. The EEG is presented in a conventional way and conventional signal processing is applied such as re-montaging and band pass filtering. The system is also capable of presenting digital video synchronized to the EEG if this is available. Some advanced analysis methods are provided as an aid: FFT analysis and Artifact Removal.

The software is designed using service oriented architecture enabling the possibility of reviewing data over WAN without the use of additional remote desktop software solutions.

The iEEG Centrum is the main patient and user administration area. It is used to manage patient demographics, keep track of exams and manage user access to clinical data. The system can be configured to allow access from the internet using encrypted communication.
The iEEG Review software is used for review and analysis of EEG data by clinical experts. The user can navigate within the EEG that can be many hours long, filter and re-montage as desired. Furthermore, the artifact removal feature can be used to automatically filter artifacts from the EEG. If video data is available, it can be shown synchronized to the EEG traces. Sections of relevance are manually marked by the user and the relevant sections are archived for long-term storage.

**Essential Performance**

The medical device is intended to be used as a tool to aid diagnosis of neurological diseases such as epilepsy. It does not provide life-support functions or monitoring of vital physiological signs. The symptoms to be diagnosed and treated are not acute in the sense that delay in the measurement will not result in harm to the patient. However incorrect output from the device could lead to an inappropriate treatment that would present an unacceptable risk to the patient.

Therefore, the Essential Performance of the device is to deliver accurate data in the following ways.

- Correct analog processing, analog to digital conversion, digital processing and host communication.
- Correctly interface to the EEG amplifier and write the data to file.
- Correctly read the data from the previously written file.
- Correctly process the data according to the specification given by the operator.
- Correctly display the data according to the specification given by the operator.
- Associate the data with the correct patient.
Connections Diagrams

System Requirements

All hardware and software components are provided and the Yoga variant arrives pre-connected inside a handy carrying case. Refer to accompanying documentation for information about approved accessories to these systems.

Refer to the following connections diagrams to ensure that all parts are supplied and connected properly.

Acceptance Test

An acceptance test form is provided with the system. After checking the system against the appropriate connections diagram, sign the form and return it with any comments. If the form is not returned, it is presumed that installation was satisfactory and acceptance is agreed.

Starting the System

To start the system, proceed as follows:

- Plug the PC into the mains supply.
- Switch on the PC and wait for the software to load.
- Ensure all components are connected according to the appropriate diagram.
- Follow the steps in the chapter, Acquire Touch.
- These procedures also apply following a mains interruption.

Shutdown of the System

At the completion of a study proceed as follows to shut down the system:

- End the recording following the steps in the chapter, Acquire Touch.
- Switch off the PC and disconnect the mains supply.
Portable System 1022 - Yoga Wireless Video

1. Camera stand should be screwed into camera back. Connect adapter to back of camera and plug into wall outlet. (One of the following two types of power adapters (1a. or 1b.) is provided.)

1a. Camera Power Line

1b. Camera Power Supply

2. Mains cable plugs into red plug and wall outlet.

3. Make sure that the power supply and USB cable are connected to Yoga PC.

4. (Optional) If instructed to do so, connect Trackit to USB extension port (4) with Trackit cable.

5. (Optional) If instructed to do so, connect Network Adapter to USB port (5).

Note: Some parts and connections are pre-installed and concealed inside the case. Contact your service provider if there are any questions concerning these components.

1. Video Camera (1 or 2) with either 1a or 1b power supply
2. Mains Cable
3. Hub and Power Supply connections to Yoga PC (Hub and power supply are concealed in case)
4. Trackit with optional USB Trackit Cable
5. Optional Network Adapter
Portable System 1020 - Yoga Wired Video

1. Camera stand should be screwed into camera back. Connect camera to ethernet cable in back of case.

2. Mains cable plugs into red plug and wall outlet.

3. Make sure that the power supply and USB cable are connected to Yoga PC.

4. (Optional) If instructed to do so, connect Trackit to USB extension port (4) with Trackit cable.

5. (Optional) If instructed to do so, connect Network Adapter to USB port (5).

Note: Some parts and connections are pre-installed and concealed inside the case. Contact your service provider if there are any questions concerning these components.

1. Video Camera (1 or 2) with Ethernet cable connection
2. Mains Cable
3. Hub and Power Supply connections to Yoga PC (Hub and power supply are concealed in case)
4. Trackit with optional USB Trackit Cable
5. Optional Network Adapter
System 1030 - Laptop Wireless Video

1. Video Camera (1 or 2) with stand or tripod
2. Camera Power Supply
3. Mains Cable
4. Medical Grade Power Supply
5. ThinkPad T450
6. Trackit Mk3
7. Trackit USB Cable
8. Bluetooth Antenna
System 1010 – Laptop Wired Video

1. Camera (1 or 2)
2. Ethernet Cable 3m (1 or 2)
3. Ethernet Cable 0.5m
4. Hub
5. Medical Grade Power Supply
6. Medical Grade Power Supply
7. Y Cable
8. Mains Cable
9. USB to Network Adapter
10. Trackit Mk3
11. ThinkPad T450 Laptop
12. Bluetooth Antenna
13. Trackit Cable
System 1040 – Laptop No Video

1. Mains Cable
2. Medical Grade Power Supply
3. Laptop PC – ThinkPad L460
4. Amplifier – Trackit Mk3 with optional USB Cable
System 1040 WiEEG – Laptop No Video

1. Mains Cable
2. Medical Grade Power Supply
3. Laptop PC – ThinkPad L460
4. Amplifier – WiEEG Model 100

Note: Refer to accompanying documents for information on approved accessories with this system.
Explanation of Symbols

**Type BF equipment**  Follow operating instructions

**Input/output connection**  Input connection

Special recycling required, do not dispose of in landfill. When this equipment has reached the end of its useful life, it must be disposed of in an environmentally-friendly way. Waste electrical and electronic equipment (WEEE) requires special procedures for recycling or disposal. This includes batteries, printed circuit boards, electronic components, wiring and other elements of electronic devices. Follow all of your respective local laws and regulations for the proper disposal of such equipment. Contact your local distributor for information concerning this.

**Consult warnings in User Manual**  Bluetooth

**Internal radio device**  WLAN WiFi

**Pushbutton**  Nonin Xpod Pulse Oximeter

**Manufacturer**  DC power

**Internal battery hazard**  Electrocap

**Battery Powered**  Serial Number

**Storage and transport symbols**

**Temperature limits**  Fragile

**Keep dry**  Relative humidity limits

**Barometric pressure limits**
Compatible File Formats

Lifelines iEEG is compatible with the following file formats:

1. European Data Format .edf
2. NicoletOne (trademark Natus) .e and .eeg files.
3. iEEG format

Accompanying Documentation

Refer to these guides for installation of the software and server:

- Lifelines iEEG Administrator Guide
- Lifelines iEEG Server Installation Guide
- Lifelines iEEG Client Installation Guide

Refer to these guides regarding these hardware components:

- Trackit Mk3 User Manual
- Lifelines Photic User Manual
- System Connection Diagram
- JNS Quick Guide

This Manual

This manual accompanies the system for easy reference. The system described in this manual describes the most extensive configuration and every option may not be configured on your system.

Concepts

Before delving into the details of each feature of Lifelines iEEG, here is a short description of some of the concepts and terms we will be referring to. Some of these are user interface items you will see as you begin using the software.

Visits

Patient Visits are managed automatically by the system. Users cannot specifically add, update or delete visits.

When a patient is admitted into the system, a new Visit is created and a new exam is initiated. Subsequent exams are added to the current visit if the user creating or importing them has full access to the visit. Otherwise a new visit is created. A visit is considered completed once all the exams contained in the visit have been archived. If the patient is readmitted after the visit has been closed, a new visit is created.
In short, each patient in the database can be associated with more than one visit, and each visit can contain several exams.

**Patient Database**

The Patient Database includes all available patients in the system, past and present plus their demographics. Patients are identified by a distinct Patient ID. The Patient Database is automatically searched when admitting a patient to the system, when importing an exam, and when reassigning an exam to another patient.

**Exams**

All information and collected data associated with a clinical test make one exam, including reports, external files and workflow state. Each exam is identified by a distinct Exam ID.

**Workflow**

Each exam type is associated with a customizable Workflow, which includes several stages beginning with Initiate and ending with Archive. The Workflow State refers to the step in the workflow that is in progress or most recently completed.

**Permissions**

Permissions are granted to patient visits by user group. Individual users can belong to more than one group. When a user admits a new patient or creates a new exam where a new visit is created, the current user’s default group is given full access to the new visit. Users are only aware of groups they are members of, while administrators have access to all groups.
Lifelines iEEG Centrum

Login

If more than one database is available, select a database then enter user name and password. Click OK.

Database Button

After successfully logging in, your user name is stored and displayed in the user name field next time you log in.

Note: If the server you attempt to connect to is a newer version than your client (but within the same major version), you will be prompted to upgrade. Click yes to download and install the new version.

Multiple Databases

Note: Non-acquisition systems only

To add a new database, click the Manage Connections icon then click the Add button on the Connection List. Under Connection Properties, give the database a name, select the host type from the dropdown list and enter the host path. Enter the port number in the Port field. Click Save to add the database to the Connection List.
Add New Connection

You can also import a database. Click the Import button, browse for the database and click Open.

To delete a connection from the list, select it and press the Delete button.

Go back to the Login via the Login button on the top-left corner of the screen.

The User Interface

The main navigation of Lifelines iEEG Centrum is a row of tabs across the top of the screen. The tabbed pages are divided into panes by vertical dividers. The size of the panes can be adjusted, if necessary, by dragging the dividers to the right or left.

Patient List

The Patient List tab is the main work area of iEEG Centrum and the first thing you see after logging in. Here you can search for patient visits, view and edit the corresponding patient and exam properties, and schedule new exams within a current visit. You can follow a workflow path associated with each exam, including launching external modality applications. You can also create and view reports or add imported documents to the patient visit. Read on for a detailed description of each section of the Patient List screen.

Patient Visits

The Patient Visit list shows a list of patient visits currently in progress. Click on a patient in the Patient Visit list to activate the Visit Properties on the right side of the screen. The Exam List will pop out below the selected patient visit. The items on the Patient Visit list can be sorted by clicking on each list header, for example, sort by Patient ID or Last Name.
Patient Visit list sorted by last name

<table>
<thead>
<tr>
<th>Patient ID</th>
<th>Last Name</th>
<th>First Name</th>
<th>Date of Birth</th>
<th>Created</th>
<th>Access Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB080942365</td>
<td>Browne</td>
<td>Shady</td>
<td>8.9.1944</td>
<td>5.3.2012</td>
<td>Full Access</td>
</tr>
<tr>
<td>AC0495805521</td>
<td>Crimson</td>
<td>Alicarin</td>
<td>45.1980</td>
<td>1.3.2012</td>
<td>Full Access</td>
</tr>
<tr>
<td>RM15101965</td>
<td>Madder</td>
<td>Rose</td>
<td>15.10.1965</td>
<td>1.3.2012</td>
<td>Full Access</td>
</tr>
</tbody>
</table>

If the list is very large, it will be displayed in pages. Click the arrows or page numbers at the bottom of the list to scroll through the pages. If you want to change the number of exams that are displayed on each page, type a new number in the Items per page box.

**Search**

Begin typing a name or search phrase to narrow down the choices displayed on the Patient Visit list. It is possible to search by the following criteria: Patient ID, Social Security Number, Name (Last, First or Middle), Street Address, City, Zip Code, Patient Notes and Exam Notes.

**Filters**

You can also narrow down the search by selecting filter options. The filters can be used to display only patient visits containing exams of a specific exam type, in a particular workflow state, or within a certain time frame. Select specific dates by typing in the “from/to” fields or clicking on the calendars. Use the Assigned to Me or the Include Archived check boxes to further filter the Patient Visit list.

**Exam List**

To display the Exam list, click a visit on the Patient Visit list to select it. The Exam list pops down under the patient visit. Click on an exam from the list to reveal the exam properties and workflow associated with that exam, and also to activate the buttons described below.
Exam List & Buttons

Add
Click the Add button to initiate a new exam associated with the selected patient visit.

Associate
Click Associate to assign the selected exam to another patient.

Export
Click Export to open a dialog allowing you to choose the location of the exported file and the file format you want the exported file in (.ieeg or .edf).

If ieeg is selected, you can check whether you want to include video or attachments, unless you choose Anonymize. Then the video and attachments options are disabled. If edf format is selected, the exported file will be anonymous with no video or attachments so those options are disabled.

Import
The Import EEG button is available when the exam has been recorded using the amplifier recording mode. Use it to import the data from the amplifier storage to the local iEEG database; you can then use Transfer to upload the exam to the server.

**Transfer**

The Transfer button is available when the exam has been recorded locally. Clicking it uploads the selected exam to the server.

**Archive**

Click the Archive button when the exam is ready to be archived.

**Delete**

Click the Delete button to delete the selected exam on the exam list.

**Exam List Indicators**

To the left of each exam on the exam list, you may see these icons indicating the following about the exam (from left to right):

- Up Arrow in Green Circle: Exam is ready to be uploaded from this computer.
- Up Arrow in Gray Circle: Exam is ready to be uploaded from another computer.
- Up Arrow in Orange Circle (blinking slowly): Upload is in progress.
- Disk Icon: Data is ready to be imported from amplifier.
- Yellow Triangle: Warning to archive exam.
- Orange Triangle: Exam archive is overdue.
- Red Bolt Icon: The exam includes spike and seizure.
- Scissors Icon: The exam has been pruned.
- Video Camera: The exam includes video.

**Visit Properties**

When a patient visit is selected from the Patient Visit list, the visit properties appear in the right-hand section of the screen, with the name of the selected patient appearing at the top. The visit properties consist of tabbed pages with information related to the currently selected
patient visit. When an exam is selected on the drop-down exam list (see above), the exam properties also appear. These tabs are all described in detail below.

**Patient Properties**

The Patient Properties tab shows the patient demographics of the selected patient and the fields (besides ID) are editable. Upload a photo by clicking on the Upload Image rectangle and browsing for a photo. Be sure to click Save after editing.

**Permissions**

Use the Permissions tab to assign access rights to the selected patient visit. Access rights are assigned to user groups. When a user initiates a visit, the user’s default group automatically gets full access to the visit.

Users with full access to a visit can give other user groups access to the visit. Be sure to click Save after changing or assigning permissions.
The permissions options are as follows:

**Full Access:** user can see and edit all patient and exam information, delete and archive.

Example: Technologists, technicians

**Analysis:** user can see and edit all patient and exam information, but not delete or archive.

Example: Doctors

**Blinded:** user can view EEG but no patient identifiable data. Can edit but not delete or archive.

Example: Research, pharmaceutical trials

**Read Only:** user can see all patient and exam information, reports and video, but not edit.

Example: Review for reference.

**Anonymized:** user can view EEG but no patient identifiable data and cannot edit.

Example: Educational, second opinions

**No Access:** users with no access cannot see the visit.

See the Admin View > User Administration for information on creating user groups, assigning users to groups and selecting the default user group for each user.
Visit Reports and Docs

On this tab is a list of all reports and documents created or uploaded during every exam of the visit. You can view, publish or delete reports here, but new reports must be created for a specific exam under the Exam Reports and Docs tab (see below).

Exam Properties

To display the Exam Properties you must first select one of the exams on the Exam List (see above). The exam properties also include the Patient State, Exam Reports and Docs, and Exam History tabs.

The Exam Properties tab shows information about the exam, such as exam type and workflow state (see image below). To edit the info, simply type in new information or make selections from the drop-down lists and then click Save.

Note: Not all fields are editable at all times.

Note: The date and time may change between the scheduled and recorded states to reflect the actual time the recording was started.

Patient State

On this tab you can enter information about the Patient’s state during the exam, medication or other notes. Press Save to save any changes.
Exam Reports and Docs

This tab allows you to create, edit and publish reports, as well as import externally created documents to associate with the exam.

Click New to create a new report with a report template.

Select a report on the list and click Open to view or edit an existing report.

Select a report on the list and click Publish to create a PDF copy of the report. It is then marked as published on the list and a version number is assigned. The original document remains on the list in case you need to further edit it.

Click Import to browse for a document to import and associate with the exam. Users must have full access to do this.

Click Delete to delete a selected report. Published reports cannot be deleted.

See more information about creating and editing report templates under The Admin View>Reports.

Exam History

View the workflow history of the selected exam. This information is automatically generated and not editable.

Workflow

When an exam is selected on the Exam list, the workflow for that exam appears along the bottom part of the screen. The highlighted (yellow) button indicates the current stage of the exam in the workflow. The next button in the row (blue) is an active button than can be pressed to perform the next stage of the workflow, and a back button becomes active when it is possible to go back to the previous step.

Workflow Buttons

Initiate

When a new patient is admitted or a new exam is created, it is in the initiated state and the Initiated button will be highlighted in yellow. The Schedule button then becomes active.

Schedule

Press Schedule to schedule the exam. The system automatically schedules the exam to the current date and time. The Date and Time fields of the exam properties become active if you want to schedule the exam to a later date and time. The Record button now becomes active.
Record

Click Record to launch the modality application associated with the Exam Type selected when the exam was created. The workflow state is now “Recording”.

The associated modality is defined under Admin>Definitions>Exam Type.

Note: It is not possible to start another acquisition until the current one has completed.

Record Now

The Record Now button is located to the right of the workflow and allows quick launch of the recording if necessary even before the exam has been scheduled.

Import

The import button is not an active button. Depending on your modality settings as defined in Admin>Definitions>Modalities, importing may begin automatically, either during recording or after. Locally recorded exams skip the import step and move to the Recorded state after the recording is completed.

Review

After the exam has reached the Recorded state, the Review workflow button is activated. Press it to open the selected exam in iEEG Review. You will also be prompted to set yourself as the reading physician for the exam.

Note: You can also double click an exam on the Exam list to launch iEEG Review.
Review Button

The Review button replaces the Record Now button to the right of the workflow bar. If you are recording locally, you can begin Reviewing the exam while recording.

For non-local recordings, if your modality has been configured to allow Online Import, you can begin to review the exam in near real-time while it is being recorded. Otherwise, you can begin review after the exam is recorded and transferred to the server.

Archive

For an exam to be archived, it must be moved to the Archive workflow state. Doing so finishes the workflow for the exam.

The exam data is then moved to the archive path and the exam is no longer visible on the Exam List unless the Include Archived box is checked.

Patient Admission

Use the Patient Admission tab to enter a new patient into the database, and also to start a new patient visit or initiate a new exam with an existing patient.

Begin by typing a name or Patient ID into the spaces provided under Patient Properties and the system searches the Patient Database for matches. The Patient Database is shown next to the Patient Properties form.

New Patient

If no match is found, continue entering information and click Save to add the patient to the database. You can now enter an Exam ID under the New Exam area of the screen and click Initiate to initiate a new exam. A new patient visit is added to the Patient Visit list on the Patient List tab.

Note: Both the Patient ID and Exam ID are required fields.
New Exam

If a match is shown on the list in the Patient Database, click the entry to select it and the rest of the Patient Properties will be filled in. Enter an Exam ID under the New Exam section and click Initiate to initiate a new exam. If the patient already has a visit in progress, the exam will be added to that visit which appears on the Patient Visit list on the Patient List tab. If the previous patient visit has already been archived, a new patient visit is created when you initiate the new exam.

WARNING: It is important to enter the correct ID associated with the patient so exams can be interpreted correctly.

Existing Patient

Import makes it possible to import exams recorded on another device into the system. They are then converted into the native format so they can be edited, pruned, etc.

Go to the Import tab to select a file for import. Click the file folder icon to browse for the file.

Note: Pressing the Import workflow button will also take you to the Import tab for exams initiated on the iEEG system.

Select the exam type if it is not already selected.

Check “Enable compression” if you are on a slower connection. This will compress the EEG and video files before transferring to the server.

If Spike & Seizure Detection (Persyst) integration is installed on the iEEG Server, check “Spike/Seizure Detection” to run the seizure detection algorithm as a part of the import process. System detected events will be inserted at the top of the channel chart where the system has detected seizure and will also appear on the Event List.
WARNING: The Persyst User Manual must be read before using the Spike & Seizure Detection feature.

**Browse to import an exam on the Import tab**

If the patient information associated with the file is not already in the database, the following popup dialog appears asking if you want to save the information to the database. Fill in the appropriate information and click Save.
Save to Patient Database Dialog

The patient in the exam does not exist in the database. Do you want to save the patient to the database?

Associate

If there is no patient information included in the file, or if you need to reassign the exam to another patient, click the Associate button.
Enter the patient information under Patient Properties. If matches are found, suggestions will populate the Patient Database list shown below the patient information. Select a patient from this list and the rest of the info will be filled for you. Click Save.

![Warning](image)

WARNING: It is important to enter the correct ID associated with the patient so exams can be interpreted correctly.

**Permissions on Import**

If you want to override the default permissions, you can assign permissions to the selected exam before importing. Click the Permissions button to open a popup window to select the permission level for each user group.

**Import Button Bar**

![Buttons](image)

See a description of the permissions levels under Patient List>Visit Properties.

**Preview**

Click the Preview button to open the data file in a simple viewer if you want to view the EEG before importing.

**Prune before Import**

While previewing the exam, it is possible to use the prune events to import a pruned version of the exam. Insert prune events at the desired locations and click Import in the top left corner. This will close the preview and prompt you to import either the pruned or full exam.
Caution should be taken when initiating a prune operation to ensure that the correct and accurate data is transferred and/or stored on the server.

**Exam Properties**

When importing from the Import tab, it is possible to change or add to the current exam properties by typing in new information before clicking Import.

**Patient Visit**

If a current visit exists for the patient that is not read only and that the current user has full access to, then the exam is associated with that visit. Otherwise, a new visit is created.

If more than one open visit exists for the patient, the following window will pop up prompting you to select the visit you want to associate with the exam.

![Multiple open visits are available for this patient. Select the one you would like to use.](image)

See the section Intro>Concepts>Visits near the beginning of this manual for more information about the meaning of Patient Visits.

**Import Cost**

The import cost appears above the row of buttons before importing.

Note: this does not include the cost of running spike and seizure detection even though this option is selected.
**Progress**

The importation can take some time depending on the size and complexity of the file. You can monitor the progress on the Processing tab.

**Processing**

On the Processing tab, you can monitor the progress and results of processes such as file importation, video encoding or archiving, to name a few.

The left side of the screen shows the progress of each action with a progress bar, and the right side of the screen shows the results of the process. The progress bars on the right side of the screen are color coded to match the results, which are also printed in text above each bar along with the process type, file name, and time and date stamp.

Green = the process completed successfully.

Yellow = the process completed with warnings.

Red = the process failed.

Blue = the process was cancelled.

*Completed processes*

![Completed processes](image)

**Buttons**

Click the x box of any progress bar while processing to cancel the process.

Click the circular arrow icon to retry a failed process.

Click the i icon for additional info (if available) about the process.
My Settings

Connection List
Here you can add or import new database connections. Click the Add or Import button and type in a name and path for the database under Connection Properties. (If importing, the path will be filled in already). Select between net.tcp and https from the combobox.

Connection Properties

Click Save and the database will be added to the Connection list and will then be available when logging on to the system.

Select a database from the Connection list and click Delete to remove the database from the list.

Note: Multiple databases is only supported on non-acquisition systems.

Settings

Change Password

Click Change Password to change your password. You will be asked to type in your old password, a new password and your new password again to confirm. Click Reset to complete the process.
Language

Choose your default language from the drop-down list.

System Font

The ability to choose a system font becomes available if your default language requires a special font.

The Admin View

If you have administrator access rights, you will see the Admin button on the top-left corner of the screen, next to the tabs. Click this to display the admin tabs. When you are in admin view, the button on the top-left changes to Patients, to take you back to patient view.

The following sections describe the various features available on the Admin tabs and how they work.

Admin Button

Admin Tabs & Patients Button

User Administration

Access to the Lifelines iEEG system is password protected. Only defined Users have access to the system. Users that have administrative privileges can manage user accounts.

Add Users

Before adding users to the system, you first need to add some User Groups and Roles to associate with the new users. See the User Group and Roles sections below if you have not already added user groups and roles.

To add a new user, click the Add button under the Users section of the Users tab, then fill in the information in the form that appears below. The email field is optional, but the rest of the fields are mandatory. Note that users can belong to more than one user group. Users (besides administrators) are only aware of user groups they belong to.
If a user belongs to more than one user group, you can select the user’s Default Group. That is the group that gets full access to new exams the user creates.

If you want the user to be an administrator, check the Administrator box. Administrators have access to the Admin tabs and can edit everything in there, and they also have full access to all visits and user groups. Administrators are marked with a green A on the Admin column of the Users list.

To lock a user out of the system, check the Locked Out box. Locked out users are indicated by a lock icon in the Locked Out column of the Users list.

When all mandatory fields have been filled in, the Save button becomes available. Clicking it opens a password dialog box. Enter and confirm the password and click Reset.

The new user is now ready. You can add as many users as you want and it is possible to modify their properties afterwards, except for the User Name.

**Search and Filter**

Use the Search box to filter the Users list by text string. Select an option from the ‘Filter by user group’ drop-down list to filter by a specific group or show users from all groups.
Image shows the Users list filtered by the letter J.

User Groups
Permissions are granted to patient visits by User Groups. To create a user group, click Add on the User Group tab under Settings on the Users tab. Type in a name for the user group and click Save. You can add as many user groups as you want and you can change their names afterwards.

Roles
To add a new role, click Add on the Roles tab under Settings on the User Administration tab. Type in a name for the role and click Save. You can add as many roles as you want and you can change their names afterwards.

Password Policy
On the Password Policy tab, you can set requirements for passwords such as minimum number of characters, or whether a certain number of special character, numbers or capital letters are required. Click Save to save the changes.

Reports
Lifelines iEEG offers the ability to create custom Word report templates to allow different reports for different exam types. The custom report templates are then available for selection when adding a new report to an exam.

Associate Workflow State
It is also possible to associate a report template with a specific workflow state of an exam type. Then the associated report template pops up automatically when the exam reaches the specified workflow state. (See Definitions > Exam Types to do this.)

Associate User Group
In addition, you can choose to associate user groups with a report type. Then, only members of allowed user groups (as well as administrators) will see and have access to those report types. To do so, select the report from the Report Template list to show the allowed and denied user groups below. Double-click a group from the denied list to add it to the allowed list. Double-click a group from the allowed list to remove it.
Create a Word Report

In the iEEG installation wizard, there is an option to set up the iEEG Report tab in Microsoft Word. This option is checked by default, but if for some reason you cannot install this add-on, you can still create Word reports using the second method described below.

**Method One - With the iEEG Report Tab add-on installed**

Click the New button to open the new template popup. Give the new template a name and select whether you want to base the template on another template, or start from a blank document. Click Add and the report template is added onto the Report Template list and Word is launched.
Edit the document just as you would any other Word document by inserting and formatting text, pictures, tables, checkboxes, etc.

You can even include macros in your report template. This could be used, for example, to populate a field based on previously provided information.

To generate the required fields from the iEEG system, insert fields from the iEEG Report tab. Select the field you want from the Report Fields list and click Add Field. These are the fields that will be filled in automatically by the iEEG system when you add the report to an exam.

Save the document and your template is now available for selection when adding a new report to an exam. (See the section Patient List > Reports and Documents).

**Method Two – Without the iEEG Report Tab add-on installed**

If you did not set up the iEEG Report Tab in Word during the iEEG installation process, you can still insert the required fields by following these steps:

1. Click New to create a new template either based on the default template or a blank one.
2. Edit as desired.
3. To insert the required fields, choose Quick Parts > Field on the Insert tab.
4. Then select the category Document Information and the field name DocProperty in the Field popup.
5. You now have a list of field properties that you can insert into the template. The fields beginning with K_ are the field properties from the iEEG system. These were copied temporarily into Word when you opened Word from the iEEG system.
6. Save and close the template.
**Edit an existing Template**

Select a template on the Report Templates list and click Open. Make the changes you desire then save and close the document.

**Import**

You can also open a Word document independently of the iEEG system, save it locally and close it. You must then import the document into the system. To do so, click the Import button, browse for the template you created and click Open.

**Licenses**

On the License tab, Administrators can check the number of cost units for each service, as well as Order History and Usage.

Click an item on the Order History list to display an order summary report which can be printed by clicking the Print button. Click the arrow on the right of the Order Overview bar to close the report.

The Usage list can be filtered by dates using the interactive calendars.

**Definitions**

**Exam Types**

You can define your own Exam Types and assign a custom workflow to each. To do so, click the Exam Types tab under the Definitions header on the Definitions tab.

Click the Add button.

Enter the exam type name in the Exam Type Name field. Select the modality from the Modality Name list and the Default Perspective you want associated with that Exam Type.
**Helper Page**

The Helper Page option is for Acquire users to be able to create and upload their own custom help page to be displayed on the Acquire Help tab with each exam type.

The helper page needs to be in .xps format. This can be easily created in Word by choosing Save As and selecting XPS Document as the type. Browse for the file using the browse button on the Helper Page text box.

![Helper Page](image)

**Disable Exam Type**

If the Disabled box is checked, the exam type will not be available for selection when adding a new exam.

Click Save to create the new Exam Type, which will now appear on the Exam Types list.

**Edit Workflow States**

With the exam type selected on the Exam Types list (on the left), you can now edit the workflow states (on the right).

![Workflow States](image)
The predefined workflow states are included and they cannot be modified or removed. It is however possible to add user-defined workflow states to the exam type. Select the desired workflow state from the Select Workflow State list and click the Plus button.

The workflow state is added to the list of workflow states and it can be moved up, down or removed using the controls.

Note that some of the predefined workflow states are fixed so user-defined workflow states cannot be added before, after or between them.

A workflow state report type can be added to a workflow state. Select the workflow state then select a report type from the drop-down list. The associated report template pops up automatically when the exam reaches the specified workflow state.

You can add as many exam types as you want and their properties can be changed afterwards.

<table>
<thead>
<tr>
<th>Exam Types</th>
<th>Modalities</th>
<th>Exam Space</th>
<th>Workflow States</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exam Type Name</td>
<td>Modality Name</td>
<td>Default Perspective</td>
<td>Disabled</td>
</tr>
<tr>
<td>Generic</td>
<td>Lifelines Trackit</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>NicOne</td>
<td>NicoletOne</td>
<td>Default</td>
<td></td>
</tr>
<tr>
<td>Video ambulatory</td>
<td>iEEG Acquire</td>
<td>Default</td>
<td></td>
</tr>
</tbody>
</table>

**Modalities**

Before you can initiate a recording of data from the system you must set the modality application used to acquire the data.

Go to the Modalities tab under Definitions and select one of the applications from the list on the left.

On the right side of the screen, click the browse button for the Recording Application.
Modality Properties

Check the correct recording device. Click Save. The modality is now set.

Import on Record
Check this box to enable automatic import of the recording, and then select one of the following options:

Online Import
Select Online Import to enable near real-time review of the exam during recording.

Offline Import
Select Offline Import if you want to start the automatic import after the recording has completed.

Exam Space
Hospitals are equipped with many devices. The ability to track which device was used when recording an exam can be simplified by defining exam spaces. Exam spaces can be room numbers, bed numbers, device numbers, etc.

On the Exam Space tab under Definitions, click Add.

Enter a name for the new Exam Space (or bed).

Default Exam Space
It is possible to specify a computer name for a selected exam space. Then when a new exam is created, the default exam space (or bed) is the exam space that is associated with the computer creating the exam.

The computer’s short name is sufficient. It is also possible to click the Use Localhost button which then generates the fully qualified name of the current computer.
Click Save.

You can add as many exam spaces as you want and their properties can be changed afterwards.

**Workflow States**

You can create custom workflow states which can then be selected when associating a workflow to an Exam Type (explained above).

Click Add on the Workflow States tab under Definitions.

Enter a name for the workflow state under Properties.

Click Save.

You can add as many workflow states as you want and their names can be changed afterwards.

**Auditing**

All user actions that deal with patient data are logged to an audit trail. Administrators can view the audit trail via the Auditing tab.

Under the Search section, you can narrow down the search results by User, Date, Category and Action. Click the Search button to perform the search. The results appear on the right part of the screen. Click Copy to Clipboard if you want to paste the results into an Excel or Word document.

**Bulk Archive**

The bulk archive feature makes it possible to archive multiple exams at once. Select a date on the calendar to show exams that should be archived by that date. Click Select All or Select None at the bottom of the list, or use the Shift or Control keys to select multiple exams. Then press the Archive Selected button.
Acquire Touch

Intro

The Acquire Touch client is optimized for touch screen laptop or tablet devices and allows the acquisition of up to 32 channels of EEG, as well as synchronized digital video from one or two cameras. Acquire Touch comes installed on a dedicated touchscreen yoga or laptop pc. It includes a protected bedside mode feature so the device can be taken to another location and left unattended for longer recordings.

Starting the Exam

Acquire Touch is launched automatically when the device is turned on and the login screen appears. Log in, and the first of a series of screens appears – the Select Patient screen.

Acquire Login Screen

Note: Some laptop versions of the portable system include Centrum on the same device. If you are launching Acquire Touch from Centrum, you will skip the Select Patient screen and arrive at the next screen, Setup. See the Centrum chapter for more information on launching from Centrum.
Select Patient

Select Patient Screen

Select a patient from the list, or enter a new patient by pressing the Enter Patient button and filling in the information in the Enter Patient popup.

The Assigned to Me button filters the list to show only exams assigned to the currently logged in user. Deselect this option to view the complete list of available exams.

Enter Patient Popup

Note: If you need to start the exam immediately, press Quick Patient. You can then enter the patient information later and associate it with the exam in Centrum.

If the amplifier has previously been detected by the system, the EEG and Start buttons will be activated; either one will start the recording.

If the amplifier has not yet been detected, or if you want to select a new amplifier before starting the recording, go to the next step, Setup.
Setup

Amplifier Setup Screen

Touch the Setup button at the bottom of the screen to access the Setup screen.

Note: You must have a patient selected in order to enable the Setup screen.

Select Perspective and Amplifier Setup

Select the Acquisition Perspective and Amplifier Setup from the dropdown lists at the top of the screen.

Use the Add button if you need to add a new amplifier setup to the list.

WiEEG

WiEEG users will have have the Perspective and Amplifier Setup pre-selected, and the setup screen will appear as shown below.
Search for Device

Press Search for Device to open the Search popup.

Select Bluetooth or USB (make sure the USB cable is connected if you choose that option).

Press Search to populate the list with available devices and select the one you want. Press OK.

Note: If you are using the WiEEG amplifier and it is not detected, you may need to restart the amplifier. Refer to the WiEEG Quick Guide for instructions.

The EEG button and Start button will be activated as soon as the amplifier is detected. Either one will start the recording.

Sync

Press the Sync button to synchronize the local and server perspectives.
Edit Channels

Press the input number to toggle a channel on or off – green indicates on, blue indicates off.

Toggling a blank channel (or pressing the white label) will display the input settings popup. Choose the desired label and press OK.

Input Settings Dialog

Common Sampling Rate

Select the sampling rate to be used for all channels.

EEG Storage Mode

Select the desired storage mode from the dropdown list.

PC = EEG, video and events are recorded to the computer hard disk.
Amplifier = EEG is recorded to the Amplifier CF card; video and events are recorded to computer.

PC & Amplifier = EEG is recorded both to Amplifier CF card and computer; video and events are recorded to computer.

Ambulatory = EEG is recorded to Amplifier CF card and no video is recorded. This mode is used for setting up more than one ambulatory recording from the same laptop or tablet system.

**Server Upload Mode**

Choose Online to have the data uploaded automatically, or manually to upload only when you’re ready.

**Record Video**

Select the cameras you want to record from. Unchecking both disables the Video setup screen.

**Video File Length**

Select the duration of each video file upload to the server.

**Save, Apply, Discard**

Press Save to save any changes to the perspective.

Press Apply to apply the changes to the current recording only.

Press Discard to cancel any changes.
Impedance

*Impedance Screen*

Check the impedance on this screen. Select the threshold level from the dropdown list. The green color indicates that impedance is within the selected threshold. The color changes to orange when the impedance is above the selected threshold.

Note: The Impedance button is disabled if the amplifier is not connected and turned on.

Video

Check that the video is displaying properly and change the Resolution and Bitrate if desired.
When you press EEG button, the signals begin recording automatically and the appearance of the Start button changes to a green Pause button. You can pause the recording if needed and then just press Start to begin recording again.

Note: The EEG button is disabled if you have not yet selected a patient to record and connected the amplifier.
**Indicators**

When the recording has started, the following indicators will appear:

- Percentage of the recording that has been uploaded to the cloud (this will not appear if you are uploading manually).
- Amplifier battery life.
- Elapsed time of the recording.

![Indicators Image]

**EEG Toolbar**

On the EEG screen, you can add events, change filters, perform a hyperventilation test, photic stimulation and view EEG and video. Press the buttons along the right side of the screen to hide/show these tools.

**Events**
Press the Events button to display and hide the event pallet. Press an event to enter it at the top of the trace display at the point in time of entry. If the event is a duration event, press on the event again to end it.

Annotation events allow you to enter text to the event.

**Toolbar**

The toolbar allows you to change several parameters on the channel chart. They are: sensitivity, paper speed, montage, low cut filter frequency, high cut filter frequency and the notch filter toggle button.

**Hyperventilation**

Press Start HV to start the hyperventilation timer. The button changes to Post HV, which you can press when you want to start the post hyperventilation timer. The button then changes to Stop HV which stops the timer. Finally, it changes to Reset so you can reset the times to zero.
**Photic**

Before using the photo tool, be sure to change your recording montage from the default to Input.

Select a pre-configured Flash Program from the drop-down list. Press the arrow button to start the sequence. The button changes to a Pause button so you can pause or resume the sequence at any time. Click the reset button to reset the sequence at the beginning. The list on the right shows the progress of the sequence as it runs.

To start the photic manually, choose a frequency on the slider bar and press the arrow button to the right of it. Press the large blue button to stop.

To produce a single flash, press the button with the sun icon.

The large Stop button stops the photic immediately, regardless of whether you are using manual or program mode.

**Video**

Press the video button to hide or show the live video.

**Toolbar Configuration**

You can choose to hide some of the side toolbar buttons by pressing the small arrow button at the top of the side toolbar. Uncheck the items you want to hide.
Lock

When you are finished with the EEG screen and everything else is as you want it, press this button to go to the locked patient mode. Note that the patient mode will not be locked if not recording. Unlocking requires logging in again.

Locked Patient Mode

Patient View

In this mode, it is possible to view video, and optionally, EEG, and also to enter events by pressing the event buttons along the lower edge of the screen.
Indicators

Indicator icons at the top right of the screen represent (from left to right) recording status, connection to the amplifier, connection to the server (cloud), connection to the internet, amplifier battery life, connection to wall outlet and remaining time available on disk. If everything is connected properly, the indicators are green; if there are any interruptions, the corresponding icon will change to orange or red.

In addition, the words “Not Recording” appear on the screen if connection to the amplifier is lost.

Note: “Not Recording” also appears if the user pauses the recording.

The current time and the patient’s name and ID are displayed at the top left of the screen, with elapsed time displayed below the current time. The most recently entered event is displayed near the indicator icons.

Display Options

If you have more than one video camera, you can view one at a time or both using the tabs at the top of the video display. If you have the EEG or Trend options enabled, those will also appear on a tab.

Help

A help screen is provided to be able to view custom created documents for each exam type. To create a help document, start by creating the file in Word, then choose Save As and select XPS Document as the file format.

To upload the help document you created, go to Centrum>Admin>Definitions>Exam Types. Under the Exam Type Properties, click the Browse button (folder icon) on the Helper Page option. Browse to the XPS document you want to upload and click Open. Click Save to save the Help file to the exam type. (See also the section The Admin View>Definitions>Exam Types).

Centrum>Admin>Definitions>Exam Type
Unlock

Press the Unlock button (you will be prompted log in again) to return to setup mode to change settings or stop the recording.

End the Recording

When you are finished recording, go to Unlocked Mode and press the Close X at the top right of the screen. You will be given the option to close the client while continuing to record, or to stop the recording completely.

Note: If you are ending a Quick Patient recording, you will get a reminder to associate it with the correct patient.

Manual Transfer of Exam

If you choose to manually transfer the exam to the server, log into Centrum, select the exam on the Exam List and press the Transfer button.
Lifelines iEEG Review

Lifelines iEEG Review allows advanced review of EEG exams of up to 128 channels and 2 synchronized video captures. Other features include event placement and annotations, customizable montages and filters, pruning and optional spike and seizure detection.

Launch iEEG Review

The iEEG Review client can be launched by selecting an exam in the Centrum client and pressing the Review button, or you can launch the Review client directly.

WARNING: To ensure accuracy, before reviewing an exam for the first time on a new screen, or when adding a second screen, the screen must be calibrated under Settings > My Settings > Screen.

Exam Mode

If you have selected an exam in Centrum and pressed the Review button, the exam will be opened in review mode, where you can begin review of the exam immediately.

If you have launched Review without first selecting an exam, the client opens on the Exams tab in exam mode. You will also see tabs for Import, Processing and Settings.

You can switch between exam and review modes via the left arrow button located on the top left of the screen.

Note: Review mode is only available after at least one exam is selected and opened for review.

Exam mode tabs

Review mode tabs showing 2 exams open

Exams Tab

On the Exams tab you will find a sortable list of current exams ready to be reviewed. Click the headers (Patient ID, Last Name, etc.) to sort the list by that header.

The list can be filtered by recorded date, exam space, workflow state, and further filtered by checking the Assigned To Me box. Check Include Archived to also show archived exams. Click the refresh button to make sure the list is always showing the most recent entries or changes.
If the exam list is very large, it will be displayed in pages. Click the arrows or page numbers at the bottom of the list to scroll through the pages. If you want to change the number of exams that are displayed on each page, type a new number in the Items per page box.

Select an exam on the list and press Review in the bottom-right corner to open the exam for review.

If the exam is in progress, click Control to gain remote control of the recording in Acquire.

Click the Clinical History icon to show the history for that exam. Click the Change Log icon to display the dates of each workflow state for the exam. Click the Reports icon to view, import or create reports to associate with the exam.

**Import Tab**

The Import tab in iEEG Review works the same as in iEEG Centrum. Refer to the Centrum chapter for more information.

**Processing Tab**

The Processing tab in iEEG Review works the same as in iEEG Centrum. Refer to the Centrum chapter for more information.

**Settings Tab**

Lifelines iEEG Review is highly customizable to the way you review data. You can create your own montages and event palettes, then save them to a group of settings called Perspectives. This allows you to quickly switch between the settings that are available during review.

See the Settings chapter for a full description of the settings features.

**Review**

The review screen is where the review of exam data takes place. The following diagram shows the review screen with the main components labeled. These components are described in the following sections.
The iEEG Review Screen

Channel Chart

The Channel Chart is where the exam data, such as EEG channels and events, are presented. The display of the chart is highly customizable, for example by user-defined montage, timebase, filters, sampling rates and display of individual channels.

This section describes the navigation of the Channel Chart and the modifications that can be made quickly during review.

Detailed descriptions of how you can further customize your Channel Chart are found in the Settings chapter.

Timeline

The Timeline is located above the Channel Chart and provides a visual representation of the duration of the exam.

Tic marks on the timeline show evenly spaced intervals. The actual interval depends on the length of the exam. You can click anywhere on the timeline and the Channel Chart will display that page.

Note: it is also possible to display the timeline below the channel chart. This is done in Settings>My Settings.

Current Page Marker

A red, translucent marker indicates where the current page is located on the timeline. Hover over the red marker to see a tooltip with the current page’s start time and date.
**Timeline with red current page marker**

![Timeline with red current page marker]

**Zoom Bar**

The Zoom Bar is located directly over the timeline. Its purpose is to be able to zoom into a long timeline so you can see the overview more clearly. To zoom in, drag either the left or right end of the zoom bar to shorten it. The zoom bar then works a bit like a scrollbar. You can move the zoom bar to the right or left to show later or earlier parts of the timeline.

**Resize the Zoom Bar by dragging to zoom in or out**

![Resize the Zoom Bar by dragging to zoom in or out]

Paging while you are zoomed into the timeline will cause the zoom bar to move so that the red current page marker is always visible.

**Segment Breaks**

Segment breaks in a recording are indicated on the timeline with small white triangles.

**Event Overview**

Events are indicated on the Event Overview just below the timeline. They appear as small, vertical bars in a brighter shade of the color of the event marker, except for Duration Events, which appear as horizontal bars for the length of the duration. Click on any event on the overview to go to that event in the Channel Chart.

**Timeline showing current page marker and event overview**

![Timeline showing current page marker and event overview]

**Video Overview**

If video is present in the exam, a dark red bar appears in the overview just above the timeline. A second video appears in dark blue. A continuous bar indicates that video is present during the entire recording. Breaks in the bar indicate breaks in the video.
Timeline showing 2 video recordings

Toolbar Controls

Located near the top of the screen just below the tabs area is a toolbar with controls affecting the navigation and display of the Channel Chart. Here you will find controls for paging, sensitivity, time base, montage, filters, perspective, and other tools - all described in the sections below.

Paging

The left and right arrows are the Auto Paging Buttons. Press once to begin paging forward or back, again to stop. The paging speed can be set using the drop-down list, or use the slider bar to raise or lower the paging speed. The drop-down list is editable: type in a new value and press the Enter key to save. Note: paging may slow down due to heavy data or high network activity.

Sensitivity

Use the Sensitivity drop-down menu to select another value, or use the up/down arrows on the toolbar to change the value one step at a time. The drop-down list is editable: type in a new value and press the Enter key to save.

Use the up/down keys on the keyboard to increase/decrease sensitivity by a factor of 2.
Sensitivity menu

Timebase

You can control how much data is displayed on the channel chart (time-wise) by setting its timebase. According to which default timebase mode has been set (see the Settings>Perspectives to change the timebase mode), you will see either the Paper Speed or Page Duration drop-down menu on iEEG Review toolbar, where you can quickly change the timebase while reviewing. Alternatively, you can use the up/down arrows next to the drop down list to increase or decrease by one step. The drop-down list is editable: type in a new value and press the Enter key to save.

Change timebase controls – paper speed and page duration

Montage Selector

Quickly change to another montage using the Montage Selector. Select As Recorded to view the montage used during recording minus any applied filters. To view the As Recorded montage plus the filters applied during recording, use the back arrow button. Use the double arrow button to go back to the previously selected montage.

Montage Selector

Filters

The next three controls on the toolbar are the filter controls – Low Cut, High Cut and Notch. Select a value for low or high cut. The drop-down lists are editable: type in a new value and press the Enter key to save.
Filter Controls – Low Cut, High Cut and Notch

Click the Notch icon to toggle the notch filter on or off. Click and hold the button to get a popup window where you can change the frequency between 60 and 50. You can also change this under Settings > My Settings.

Prune Preview

Pruning is used to selectively throw away unwanted parts of an exam. The Prune Preview button is used to view the effects of the prune settings before actually throwing out any data. The button is a toggle button so you can view the effects of pruning and then go back to the previous view.

The Prune Preview toggle button

The Prune Preview button becomes active when you have marked certain events as Prune Events. To learn how this is done, see the Events section of the Settings chapter of this manual.

To make the prune effects permanent, select the Prune option on the Menu.

Frequency Analysis

It is possible to perform frequency spectrum analysis on any of the traces as they are displayed in the review screen. To do so, click the FFT button in the Measurement Tools panel, then select a portion of a trace by either clicking on the start point of the channel and then again at the end point, or by dragging from the start point to the end point. A box is drawn around the selected portion of EEG on the channel chart as shown:
A popup window opens with the calculations as shown:

**Frequency Spectrum Window**

The results for the selected EEG shown in the frequency spectrum window are calculated with the Welch’s method:

1. The signal selected by the user and as displayed, i.e with same filtering settings, is divided into 2-second blocks, overlapping by 50%.
2. If the sampling rate is not in power, each block is zero padded until next the power of two samples.
3. If the last block is not a full 2 seconds, it is zero padded until it is 2 full seconds.
4. The mean is subtracted from each block (**Detrend: Average** as shown in the results window)
5. Each block is windowed by a Hamming window function.
6. The periodogram is calculated of each block using a standard FFT algorithm with 0.5 Hz frequency resolution.
7. All the periodograms are averaged into the resulting frequency spectrum.
The power in the following frequency bands are calculated by summing the power in the frequency bins within the frequency bands:

- **DC**: 0 – 0.5 Hz
- **Delta**: 0.5 – 4 Hz
- **Theta**: 4 – 8 Hz
- **Alpha**: 8 – 13 Hz
- **Beta**: 13 – 30 Hz
- **Gamma**: 30 – 100 Hz
- **Above**: 100 – Nyquist frequency

The power values for each band is always shown in $\mu V^2$ in the first column and the relative percent power in the second column, i.e. power in the band divided by total power in all bands times 100, where total power is the sum of the power in all bands.

The spectral edge shown on the right in the Frequency Spectrum window is calculated as the frequency where the power below the frequency is x% of the total power, where x is 80% by default but can be changed by using the slider.

Click the Save to file button to save the results to disk.

**Time Domain**

The Time Domain tool is used to measure amplitude and duration of a selected section of a waveform. Click the Time Domain button and then select a section of a waveform on the channel chart either by clicking and dragging, or by clicking first on the start point and again on the end point.

A window opens showing an enlarged view of the selected waveform. Click on the waveform where you want the measurement to begin and again where you want the measurement to end. The amplitude and duration are displayed.

**Perspective Selector**

Use the Perspective Selector to quickly change the view from one perspective to another. A perspective is a group of settings that you can create and name yourself. (See the Settings chapter for more information).

**Channel Labels**

To the left of the Channel Chart you will see the Channel Labels.

You can hide the Channel Label bar by clicking the hide/show arrow button at the top of the labels. This display option is stored on the computer between sessions for each user.
Hide/Show Labels

Special Channels

You can select one or more channels by clicking on the label and then change a number of display settings or filters on those channels.

Selected Channel Label

Right-click one of the selected channels to open the Special Channel popup. You can then change the color, sensitivity, deflection, filters, display type, polarity and baseline position by using the corresponding controls. You can also choose to hide the selected label(s) or display only the selected labels(s). Click Reset to remove the special channel settings from the selected labels.

A checkbox appears in front of the label on special channels. Unchecking the box resets the settings for that channel only.

Special Channel Popup

Note: These settings are applied but not saved unless you save them on the Montage tab in the Settings.

At the bottom of the label area are two buttons. The X clears all selections and the checkmark selects all labels.
Select or deselect all labels

Event Palette

Located to the right of the Channel Chart is the Event Palette. The Event Palette contains a customizable set of event markers that can be placed either directly onto a channel, or at the top of the Channel Chart at the time of the event. The event changes are automatically saved to the central data storage. You can hide/show the Event Palette by clicking the hide/show arrow button at the top of the palette. This display option is stored on the computer between sessions for each user.

Hide/Show Event Palette

This section discusses the placement and features of different types of events into the Channel Chart. For information on creating and customizing events and event palettes, see the Settings chapter.

Place an Event

To place an event, click the event on the event palette, and then click on the channel chart where you want the event marker to appear. A vertical positioning line and crosshairs appear to help you with the positioning.

To place multiple instances of the same event, double-click the event marker first, and then you can insert an event marker onto the channel chart with each subsequent click, without having to go back to the event palette. Right-click on the channel chart to stop this action.

Note: if the montage is changed such that the channel where the event was placed no longer appears, the event marker will be displayed at the point where the active electrode appears again, or at the top of the channel chart in the case that the active electrode does not appear.

Event Shortcut Keys

Instead of clicking on the event markers, you can also use the F-keys F1-F10, which correspond to the first 10 event markers on the event palette. Press the F-key then click the channel chart to place the event.
Place Event at Video Marker

During video playback or online video review, simply click an event or its shortcut key to automatically place the event at the point of the video marker. The event marker appears at the top of the channel chart.

See additional event placing information under Duration Events and Annotation Events.

Duration Events

Duration Events are events that happen over a period of time. These event markers can be recognized as they are rectangular in shape with a bar at each end.

Place Duration Event

To place these events, click on the event on the event palette, and then click on the channel chart where you want the event to begin. Before releasing the mouse button, drag to the point where you want the event to end. In addition to the crosshairs, a translucent background color appears to indicate the horizontal area that will be covered by the event.

Placing a duration event

After placing the event, you can adjust the duration by dragging either end of the event marker to extend or contract the area being covered.

Paging during duration event placement

If the duration of the event extends for more than one page, place the event, then hover over the event marker and click the resize arrow that appears to the right of the event. You are now able to extend the length of the duration without holding down the mouse button. You can also click the Resize button and select a place on the timeline. Then click on the original channel again to end the duration event.
Click the Resize button to adjust the length of the duration

When you need to page forward, move the cursor just above or below the channel you are on and it changes to an arrow so you can click to page forward. Click again in the original channel to end the duration event.

Cursor changes to allow paging when hovering above or below the channel

Place Duration Event at Video Marker

To place a duration event while playing video, click the event marker or press its shortcut key to place the beginning of the event at the current location of the video marker, then click the marker or press the key a second time to end the event.

Event Caption

Hover over the event marker on the channel chart and click the small text box icon that appears below the event. You can then type in your own caption for the event which will appear after the event name on the event marker.

Adding a caption to an event

Annotation Events

Annotation events allow you to type in a note which becomes the caption on the event marker.

Place Annotation Event

To place an Annotation Event, simply start typing the annotation. A text box appears automatically for you to type in your annotation. The marker appears at the top middle of the channel chart, or at the video marker if video is playing.
**Context Events**

Context Events store information about the channel chart settings at the time of placement. Later, you can revert back to these settings by clicking the Context toggle button that becomes visible when you hover over the event marker.

Context events store montage, general channel settings and timebase information.

![Context Event toggle button](image)

**Numerical Events**

Numerical events store numerical information associated with the event. Hover over the placed event on the Channel Chart to select a new numerical value from a drop-down list.

**Prune Events**

Prune events are used to mark areas of the Channel Chart that you want to keep after pruning the exam. Using the Settings, you can set the number of seconds before or after the event to keep. You can also choose whether the event keeps the EEG and video, or only the EEG.

For more info about pruning, see also Prune Preview under Toolbar Controls and Prune under Menu.

**Move an Event**

Drag an event to a new position on the channel chart. This will change the timestamp of the event.

**Delete an Event**

To remove an event once it has been placed, hover over the event and click the x that appears over the event.
Deleting an event

You can also delete an event by selecting it on the Event List and clicking the delete button.

Panel

Intro

The Panel is located on the right side of the screen and contains additional tools for navigating and analyzing the exam. The individual items on the panel can be expanded or collapsed by clicking the panel headers, and the entire panel can be hidden by clicking the hide/show arrow button on the gray bar at the top of the panel. The hide/show display option is stored on the computer between sessions for each user.

You can adjust the width of the panel by dragging the left edge of the panel to the right or left.
Click the small “popout” icon in the header to open the panel item in a separate window. The window can be resized and dragged to any position. Click the close X to put the panel item back on the panel.

**Video 1 panel shown popped out**

Click the play button to start video playback. A red video marker moves across the Channel Chart to show the position of the video in the EEG data. The Channel Chart pages automatically at the rate of video playback. You can also drag the video marker to a point in the EEG to start the video at that point.

**Red video cursor**

The play button changes to a pause button while the video is playing, so you can press again to pause the video. The other buttons on the video panel are for stepping back and forward one step at a time, adjusting the volume, and adjusting the playback speed.
Zoom

Select an area of the video display to zoom into that area. After zooming in one or more times you can reset the video to the originally displayed size by a right-click with the mouse.

Event List

The Event List displays a list all of the events in the exam by name, timestamp, and duration. Click on any event in the list to go to that event on the Channel Chart.

Sort the list by name, timestamp or duration by clicking on the headers.

Change the font size of the list by clicking the font size buttons at the bottom of the list.

Click the Copy Events to Clipboard button and you can then paste the list, including all columns, to an Excel or Word document.

Click the Delete button to deleted selected events, both from the list and the Channel Chart.

To select multiple events, select an event, then hold down the control key while selecting additional events. To select consecutive events, select the first event, then hold down the shift key while selecting the last event in the row. All of the events in between will also be selected.
Event List Settings

Click the settings icon to open the Event List Settings popup. On the Event List Filter tab, you can select which events you want shown or hidden in the Event List. You can also filter by free text by typing into the Search field.

If the Persyst seizure detection is enabled, you can filter spike events by confidence threshold using the slider.

The filtered results are reflected on the Overview and Channel Chart as well as on the Event List.

The events are arranged in columns by type, category and priority. Check or uncheck the “All” checkbox to select or deselect all events in the column.

On the Other Settings tab, there is a checkbox to show or hide the date on the Event List.
Artifacts

The artifact removal feature uses advanced signal processing methods to remove artifacts from the EEG while leaving the original EEG unaffected.

Check the types of artifact removal you want to activate, then click On or Off to show or hide the effects of the artifact removal.

Note: While artifact removal is On, the system will slow down considerably for actions such as paging.

The artifact removal feature is provided as a supplement to conventional EEG processing such as band pass filtering. Artifacts are removed from one page at a time by user request.

The following image shows a page of EEG with eye blink artifact present. The artifact can be clearly seen on channels Fp2-F8, F4-Fp2, Fp1-F7 and F3-Fp1 but it is present on other channels as well to a lesser extent.
The next image shows the same page of EEG with the eye blink artifact removed.
Menu

The Menu button located at the top of the screen holds functions which are typically located on the File menu in common applications, such as Save and Print.

In addition, there are the following functions:

**Save As**

Save a copy of the exam with a new ID. The copy can also be saved pruned.

**Prune**

Select Prune to trim the exam data down to the sections marked by prune events. The system saves a copy of the exam with only the marked sections and leaves the original exam untouched. You can preview the effects of pruning first – see the Prune Preview section under Toolbar Controls.

**Undo Prune**

Undo the prune command.

**Seizure Detection**

If the Persyst Spike and Seizure Detection option is installed on the iEEG Server, selecting this option on the menu will run the seizure detection algorithm. System detected events will be inserted at the top of the channel chart where the system has detected seizure and will also appear on the Event List.

You can also run the Spike and Seizure detection automatically on import by selecting the Spike/Seizure checkbox on the Import tab.
WARNING: The Persyst User Manual must be read before using the Spike & Seizure Detection feature.

**Reports**

This takes you to the Reports and Documents tab for the exam and allows you to create a new report. Enter a name for the report in the popup window, select the report type from the drop down list, then click Add.

![Report Name and Type](image)

New report types can be created in Centrum. Refer to that chapter for more information.

**Print**

This command opens the print dialog. Select Current Page to print the currently showing page of EEG, or select Custom to choose the pages you want to print. Use the slider to adjust the trace thickness and the checkbox to include patient information.

You can also adjust your printer settings, as you would with a standard Windows print dialog.

**Demographics**

Select this option to open the patient and exam properties of the open exam. The patient and exam properties can be edited in the same way as on the Patient List tab in iEEG Centrum. Refer to the Centrum chapter for more information.

**Export Page Data**

Export a text document with the current page in numerical values (ascii).

**Settings**

Lifelines iEEG Review is highly customizable to the way you review data. You can create your own montages and event palettes, then save them to a group of settings called Perspectives. This allows you to quickly switch between the settings that are available during review. See the Settings chapter for a full description of these tabs.
Settings

Lifelines iEEG is highly customizable to the way you record and review data. You can create your own montages and event palettes, then save them to settings groups called Perspectives. This allows you to quickly switch between the settings that are available during recording or review.

This chapter describes the features under each tab of the settings.

Montage

The montage is a way to organize how the information from an EEG exam is visualized. On the Montage tab you can create montages, as well as define EEG labels, reference and other labels.

After a new montage is created, add it to a Perspective to make it available on the Review screen. (See Perspectives, later in the Settings section).

There are four tabs under the Montage tab, described below.

**Montage**

**Adding Montages**

On the Montage tab, click the Add button at the bottom of the Montage list.

*Buttons on the Montage list – Add item, delete selected item, duplicate item*

A new montage is added to the list. Double click on the montage name to edit it, then press enter.

**Duplicating Montages**

Select a montage from the list of montages.

Click the Duplicate button at the bottom of the Montage list.

Double click on the montage name to edit it.

**Deleting Montages**

Select a montage from the list of montages.

Click the Delete button at the bottom of the Montage list.
Note that the As Recorded montage cannot be deleted.

**Associate User Groups to Montage**

Select the montage from the Montage list, then move the user groups you want to have access to the Allowed user groups box using the arrow buttons and click Save. Only members of allowed user groups (as well as administrators) will see and have access to the montage.

**Adding Montage Channels**

There are two ways to add channels to a montage – drawing the channels on the Montage Head, or entering the active and reference electrodes in their respective fields.

Montages can be made by using any of the available label systems (upper right corner).

You can use still use any of the electrodes in the system, even though the selected label system does not include them.

**Drawing channels on the Montage Head**

Click on the electrode you want as the active electrode, then click on the one you want as the reference.

The channel has now been added to the montage, both to the montage head and to the channel list.

It is also possible to select an active electrode from the head and a reference from the list of References (to the right of the head).
Clicking on a reference activates it so that many electrodes can be selected from the head. Each one then becomes the active electrode against the selected reference in a montage channel.

To deselect a reference, either click on the selected reference again, or select another reference from the list.

It is possible to add Non-EEG signals to the montage (located below the head) by clicking on the electrode. The non-EEG signals do not need to have references.

It is possible to add Sources to the montage (located below the Non-EEG signals) by clicking on the electrode. The sources do not need to have references.
Entering active and reference labels

Start entering the name of the active electrode in the Active field. The system displays all available electrodes matching that name. Select the electrode you want. Do the same for the Reference field.

Once valid electrodes have been entered, the Add button becomes available.

Clicking the Add button adds the channel to the montage, both to the channel list and to the montage head.

Sources and Non-EEG signals can be added this way as well.

Deleting Montage Channels

It is possible to select channels (one or more) from the Channel list and delete them by clicking the Delete button.
Rearranging Montage Channels

It is possible to move selected channels in a montage up or down by clicking the Up or Down arrow buttons.

Making Channels Special

Special channels do not conform to the general channel settings, but have their own special settings.

It is possible to make a channel special by checking the Special box when you add the channel. The channel can also be made special afterwards by checking that channel’s Special box.

Special settings can be applied to a single channel by clicking the Special box

- Sensitivity (µV/cm) or (µV/mm) depending on the system’s default setting
- Deflection (mm)
- Baseline
- Display type (Trace/Text/Trace&Text/Off)
- Show Units (True/False)
- Polarity (Up/Down)
- High Cut Filter (Hz)
- Low Cut Filter (Hz)
- Notch Filter (On/Off)

It is possible to remove the Special settings by unchecking the Special box. After that the channel will conform to the general channel settings again.
Visibility of Channels

Channels are visible on the EEG by default but it is possible to make a channel invisible on the EEG by unchecking that channel’s Visible box.

Channel Status

The channels show their status with a colored dot, and a tool tip explains the status more thoroughly.

- The dark green dot shows if the channel is OK.
- The light green dot shows if the channel electrodes have different polarity or different sensor types.
- The orange dot shows if the channel electrodes compare AC to DC, compare digital to analog, or match unipolar with bipolar.
- The red dot shows if the channel electrodes compare different units.

Channel Color

The color of a channel can be changed by selecting it from the Color drop-down list.

Editing the color of a channel does not make it a Special channel.
**Editing Channels**

It is possible to edit the electrodes of a channel afterwards. This can be done either in the channel list itself or on the montage head.

**On the Channel List**

By clicking on an electrode (active or reference) in the Channel list, the name of the electrode becomes editable. Start entering the name of the new electrode in the field and the system displays all available electrodes matching that name. Select the electrode you want and the channel in the list as well as the channel on the head will be changed.

**On the Montage Head**

When editing channel electrodes on the head, you start by selecting a channel from the Channel list.

If the Auto Advance is off, you can select different electrodes on the head, but you are only editing the active electrode of the channel you selected. To edit other electrodes they must be selected specifically.

If the Auto Advance is on, the system will automatically move to the next electrode in the list for each electrode you select on the head. The move is from the active electrode in the selected line to the reference electrode in the selected line, then to the active electrode in the next line to the reference electrode in the same line, and so on.

**Auto Advance toggle button**

![Auto Advance button]

**EEG Electrodes**

This tab under Montage is for adding electrodes and creating electrode label systems. All of the electrodes added to the system are available for creating montages whether or not they are grouped into an electrode system.

**Adding Electrode Systems**

Click the Add Item button at the bottom of the Electrode System list.

**Add Item, Delete Selected Item, Duplicate Selected Item buttons**

![Add Item, Delete Selected Item, Duplicate Selected Item buttons]

Double click on the system's name to edit it.
**Duplicating Electrode Systems**

Select an electrode system from the list of electrode systems.

Click the Duplicate button at the bottom of the Electrode System list.

Double click on the electrode system’s name to edit it.

**Deleting Electrode Systems**

Select an electrode system from the list of electrode systems.

Click the Delete button at the bottom of the Electrode System list.

Note that the predefined 10-10 and 10-20 systems cannot be deleted.

**Adding Electrodes to an Electrode System**

Select an electrode system from the Electrode System list. Start entering the name of the electrode in the Name field. The system will display all available electrodes matching that name. Select the electrode you want and click the Add button.

The electrode has now been added to the electrode system, both to the electrode list and the head.

**Deleting Electrodes from an Electrode System**

It is possible to select an electrode from the electrode list or from the head and delete it by clicking the Delete button.

**Azimuth and Longitude**

Edit the azimuth and longitude of an electrode by clicking to activate the field and typing in a value (between -359 and +359).

**Color**

Click the color bar to select a new default “active” color for the electrode. This determines the default color of the trace where the electrode is the active one.
EEG References

This tab under Montage is used to add EEG reference electrodes which are then available when creating montages.

Adding References

Before you add a reference, make sure you have the correct electrode system selected (upper right corner). The reference you make will only be added to the chosen electrode system.

Click the Add Item button at the bottom of the reference list.

The system will prompt you with a message to enter a name for the reference. Note that the name cannot be changed afterwards.

Enter a name and select a type for the new reference and click OK.

The available reference types are: New, Average and Duplicate.

- Selecting the New reference will create an empty reference. Add combination items to the reference by selecting an available electrode from the Name list. Edit the electrode weight and click the Add button.

- Selecting the Average reference will create a reference with every electrode in the selected electrode system, each with the weight 1.
• Selecting the Duplicate reference is only possible when duplicating references (see the Duplicating References section below). Click OK to duplicate the selected reference.

**Duplicating References**

Select a reference from the list of references (except for the predefined Ref).

Click the Duplicate button at the bottom of the reference list.

Enter a name for the reference, make sure the Duplicate type is selected and click OK.

**Deleting References**

Select a reference from the list of references.

Click the Delete button at the bottom of the reference list.

Note that the predefined Ref reference cannot be deleted.

**Adding a Combination Item to a Reference**

Select a reference from the list of references. Select an electrode from the Name list and enter its weight. Click the Add button.

Note that combination items cannot be added to the predefined Ref and Gnd references.

**Deleting a Combination Item from a Reference**

Select a reference from the list of references. Select a combination item from the list of combination items. Click the Delete button.

**Other Signals**

It is possible to add signals from other sources to a montage, for example EKG, respiratory and other signal types. Use this tab under Montage to define these sensors so that they are available to add to montages.

**Adding Non-EEG Signals**

First make sure you have the correct electrode system selected (upper right corner). Type a name for the new sensor in the Name field. Note that the name cannot be changed afterwards. Select a sensor type from the Type list. Click the Add button.

If the new sensor has a unit other than µV, the Units/µV and Offset can be edited.
Each signal is measured in µV. If however the signal being measured has a unit that is not µV, the units/µV indicates how many of the signal’s unit one µV represents.

The measured signal may be biased in such a way that the zero point in the measured signal’s unit does not coincide with zero µV measured. The offset (in signal units) represents at what point in the unit’s scale the zero µV is set.

**Changing the Non-EEG Signal Type**

Select a sensor from the Non-EEG Signal list, then change the sensor type by selecting another one from the Type drop-down list.

**Non-EEG Signal Color**

The color of non-EEG signals can be changed by selecting a new color from the Color list.

**Deleting Non-EEG signals**

Select sensors (one or more) from the Non-EEG Signal list. Click the Delete button.

**Events**

Events are used to mark the EEG. The most basic events mark a noteworthy incident with a text. More complex events can be used for marking parts of the EEG for pruning, holding annotations and numerical values, and some events even store the current montage at the time of event insertion.

Use the Events tab in Settings to create event types and group them into palettes. You can then assign palettes to different Perspectives to be able to switch between them quickly during review.

**Adding Event Palettes**

Click the Add Item button at the bottom of the Palette list.

Double click on the palette name to edit it.

**Duplicating Event Palettes**

Select a palette from the list of palettes.

Click the Duplicate Selected Item button at the bottom of the Palette list.

Double click on the palette name to edit it.
Deleting Event Palettes
Select a palette from the list of palettes.
Click the Delete Selected Item button at the bottom of the Palette list.
Note that predefined palettes cannot be deleted.

Adding Event Types
Click the Add button at the bottom of the available event types list.

Editing Event Types
It is possible to edit events at all times.

Event Settings
The Name and Description fields of the event type can be edited.
A color can be selected for the event type.
The event type category can be selected from a drop-down list.
The event type priority can be selected from a drop-down list for display purposes.

Numerical Events
To set an event type as Numerical, select one of the options from the drop-down list.
Set the Minimum, Maximum and Default values.

Annotation Events
If the Annotation Event checkbox is checked, the event will be an annotation event, and display the event’s annotation as its caption.
**Prune Events**

If the Prune event checkbox is checked, the event will be a prune event. It is possible to prune (or prune preview) exams, cutting out unwanted data and only leaving the segments marked with prune events. The Prune Properties that can be edited are whether the event should Keep EEG only or Keep EEG and video when pruning.

Also, seconds before and after can be edited. These are seconds right before and after the prune event that the system will keep when the exam is pruned.

**Context Events**

If the Context event checkbox is checked, the event will be a context event. The system then saves the montage, general channel settings and time base of the exam at the point of insertion. After a context event has been added to an exam, it is possible to toggle its context button and the system will display the event’s settings.

**Duration Events**

If the Duration event checkbox is checked, the event will be a duration event. The Default Duration of the event type can be set.

**Duplicating Event Types**

Select an event type from the list of available event types.

Click the Duplicate button at the bottom of the available event types list.

**Deleting Event types**

Select an event type from the list of available event types.

Click the Delete button at the bottom of the available event types list.

Note that predefined event types cannot be deleted.
Adding Event Types to Palettes

Select the palette you want to edit from the list of palettes. Double click on the event type you want to add to the palette in the available event types list.

Removing Event types from Palettes

Select the palette you want to edit from the list of palettes. Double click on the event type you want to remove from the palette in the event types in palette list.

Perspectives

Sometimes you need the same combination of event palette, montages, general channel settings and more. You can store these combinations into a settings group called Perspectives. It is then possible to easily switch between perspectives during review, resulting in increased efficiency if you need to change the EEG environment frequently. Perspectives can be easily added and modified.

If no Perspective is created, the Default perspective is used, and its settings can be modified on this tab.

Adding Perspectives

Click the Add button at the bottom of the perspectives list.

Double click on the perspective name to edit it.

Duplicating Perspectives

Select a perspective from the list of perspectives.

Click the Duplicate Selected Item button at the bottom of the perspectives list.

Double click on the perspective name to edit it.

Deleting Perspectives

Select a Perspective from the list of perspectives.

Click the Delete button at the bottom of the perspectives list.

Note that the predefined perspectives Default and PSG cannot be deleted.
**Associate User Groups to Perspective**

Select the perspective from the Perspective list, then move the user groups you want to have access to the Allowed user groups box using the arrow buttons and click Save. Only members of allowed user groups (as well as administrators) will see and have access to the perspective.

![User Groups]

**Editing Perspectives**

It is possible to edit perspectives at all times. To edit, select the Perspective you want to edit from the list. Then modify the following settings.

**Montage for Perspective**

Select a montage from the Available Montages list and click the Add montage to perspective (right arrow) button to move the montage to the perspective. Montages can be removed from a perspective by selecting the montage from Montages for Perspective and clicking the Remove montage from perspective (left arrow) button.

Note that the As Recorded montage cannot be removed from any perspective.
Event Palette

Select an event palette for the perspective from the Event Palette list.

Default Montage

The default montage is the one that will be selected by default on the toolbar in Review. The other montages in the perspective will be available on the drop-down list.

Default Sensitivity

The perspective’s default sensitivity is selected from the Sensitivity list. The list can be edited by typing in a new value (between the upper and lower limits) and pressing Enter.

Default Deflection

The perspective’s default deflection is selected from the Deflection list. The list can be edited by typing in a new value (between the upper and lower limits) and pressing Enter.

Default High-cut Filter

The perspective’s default high cut filter is selected from the High Cut list. The list can be edited by typing in a new value (between the upper and lower limits) and pressing Enter.

Default Low-cut Filter

The perspective’s default low cut filter is selected from the Low Cut list. The list can be edited by typing in a new value (between the upper and lower limits) and pressing Enter.

Default Notch Filter

The default notch filter position can be on or off.
Timebase

You can control how much data is displayed on the channel chart (time-wise) by setting its timebase. Choose between two modes: paper speed (represents the length of the page used to display each second of the data) and page duration (represents the number of seconds per page).

Set the default timebase mode by choosing either Paper speed or Page Duration under Timebase. Then select the default paper speed or page duration from the second drop-down list. The list can be edited by typing in a new value (between the upper and lower limits) and pressing Enter.

Perspective Type

Select Review or Acquisition

My Settings

Screen

Here you can calibrate the screen for accurate representation of the onscreen channel chart. When calibrated, 1 cm displayed on the channel chart will actually measure 1 cm. The screen calibration must be performed for every new computer screen.

Using a real ruler, drag the handles on both system rulers, vertical and horizontal, so they match exactly 10 cm.

WARNING: It is important to calibrate the screen so exams can be interpreted correctly. The screen calibration must be performed for every new computer screen.

Settings

<table>
<thead>
<tr>
<th>Sensitivity</th>
<th>Paper Speed</th>
<th>Default Paging Speed</th>
<th>Notch Filter Frequency</th>
</tr>
</thead>
<tbody>
<tr>
<td>µV/cm</td>
<td>mm/s</td>
<td>30 x</td>
<td>50 Hz, 60 Hz</td>
</tr>
</tbody>
</table>
**Sensitivity**
The unit for sensitivity can be either $\mu$V/cm or $\mu$V/mm.

**Paper Speed**
The unit for paper speed can be either cm/s or mm/s.

**Default Paging Speed**
Type in a default paging speed in the box provided.

**Notch Filter Frequency**
The notch filter frequency can be set to either 50 Hz or 60 Hz.

**Timeline Position**
The position of the timeline on the screen can be set to either Top or Bottom.

**Gridlines**
Show or hide major and minor gridlines.

<table>
<thead>
<tr>
<th>Timeline position</th>
<th>Gridlines</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>Show Major Gridlines</td>
</tr>
<tr>
<td>Bottom</td>
<td>Show Minor Gridlines</td>
</tr>
</tbody>
</table>

**Change Password**
Click here to change your password.

**Language and System Font**
Select your default language. If your default language requires it, it is possible to change the system font.

**Default Perspectives**
For each exam type, you can select which perspective you want to be used as the default.
Acquisition

On the Acquisition tab, you can create your own photic programs. These programs are then selectable in the photic tool in Acquire.

Note: This tab is only available in acquisition systems.

To create a new photic program, click the Add button at the bottom of the Photic Programs list. Type in a name for the new program and press enter.

To create your sequence of flashes and pauses, enter a flash frequency in Hz. A value of zero will create a pause instead of a flash. Then enter the number of seconds you want the flash or pause to last. Press the Add button to add this item to the flash program. To delete a flash item or pause, select it on the list and press the Delete button.

Click Save to save your changes.

Appendix: Manufacturer’s Declaration

This appendix contains specific information regarding compliance with IEC/EN 60601-1-2.
**Note:** Medical electrical equipment needs special precautions regarding EMC and needs to be installed and put into service according to the EMC information provided here.

**WARNING:** The use of accessories, transducers and cables other than those specified, with the exception of transducers and cables sold by the manufacturer of the equipment as replacement parts for internal components, may result in increased emissions or decreased immunity of the equipment.

### Trackit Mk3

#### EMC Compatibility

<table>
<thead>
<tr>
<th>Guidance and manufacturer’s declaration – electromagnetic emissions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Lifelines iEEG system is intended for use in the electromagnetic environment specified below. The customer or the user of the Lifelines iEEG system should assure that it is used in such an environment.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Emissions Test</th>
<th>Compliance</th>
<th>Electromagnetic Environment Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF emissions CISPR11/EN55011</td>
<td>Group 1</td>
<td>The Lifelines iEEG system uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>RF emissions CISPR11/EN55011</td>
<td>Class B</td>
<td>The Lifelines iEEG system is suitable for use in all establishments, including domestic establishments and those directly connected to the public low voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>Harmonic emissions EN 61000-3-2</td>
<td>Class A</td>
<td></td>
</tr>
<tr>
<td>Voltage fluctuations/ Flicker emissions EN 61000-3-3</td>
<td>Complies</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Guidance and manufacturer’s declaration – electromagnetic immunity</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Lifelines iEEG is intended for use in the electromagnetic environment specified below. The customer or the user of the Lifelines iEEG should assure that it is used in such an environment.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>EN 60601 Test Level</th>
<th>Compliance Level</th>
<th>Electromagnetic Environment Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Electrostatic discharges (ESD) EN 61000-4-2</td>
<td>+/- 6 kV: Contact +/- 8 kV: Air</td>
<td>+/- 6 kV: Contact +/- 8 kV: Air</td>
<td>Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%</td>
</tr>
<tr>
<td>Electrical fast Transients/burst EN 61000-4-4</td>
<td>+/- 2 kV: AC mains +/- 1 kV: Signal lines</td>
<td>+/- 2 kV: AC mains +/- 1 kV: Signal lines</td>
<td>Mains power should be that of a typical commercial and/or hospital environment</td>
</tr>
<tr>
<td>Surge EN 61000-4-5</td>
<td>+/- 2 kV: Common mode +/- 1kV: Differential mode</td>
<td>+/- 2 kV: Common mode +/- 1kV: Differential mode</td>
<td>Mains power should be that of a typical commercial and/or hospital environment</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------</td>
<td>-------------------------------------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Voltage dips, short interruptions and voltage variations on power supply input lines EN 61000-4-11</td>
<td>&lt;5% 230 V (&gt;95% dip in 230 V) for 0.5 cycle</td>
<td>&lt;5% 230 V (&gt;95% dip in 230 V) for 0.5 cycle</td>
<td>40% 230 V (60% dip in 230 V) for 5 cycles</td>
</tr>
<tr>
<td></td>
<td>40% 230 V (60% dip in 230 V) for 5 cycles</td>
<td>70% 230 V (30% dip in 230 V) for 25 cycles 95% dip in 230 V) for 5 sec</td>
<td>70% 230 V (30% dip in 230 V) for 25 cycles 95% dip in 230 V) for 5 sec</td>
</tr>
<tr>
<td></td>
<td>&lt;5% 230 V (&gt;95% dip in 230 V) for 5 sec</td>
<td>&lt;5% 230 V (&gt;95% dip in 230 V) for 5 sec</td>
<td>&lt;5% 230 V (&gt;95% dip in 230 V) for 5 sec</td>
</tr>
<tr>
<td>Power frequency (50/60 Hz) magnetic field EN 61000-4-8</td>
<td>3 A/m</td>
<td>3 A/m</td>
<td>Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial and/or hospital environment</td>
</tr>
</tbody>
</table>

Guidance and manufacturer’s declaration – electromagnetic immunity

The Lifelines iEEG system is intended for use in the electromagnetic environment specified below. The customer or the user of the Lifelines iEEG system should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>IMMUNITY test</th>
<th>IEC 60601 TEST LEVEL</th>
<th>Compliance level</th>
<th>Electromagnetic environment – guidance</th>
</tr>
</thead>
</table>
Portable and mobile RF communications equipment should be used no closer to any part of the Lifelines iEEG, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter.

<table>
<thead>
<tr>
<th>RF Common mode/ Conducted Susceptibility EN 61000-4-6</th>
<th>Recommended separation distance:</th>
</tr>
</thead>
</table>
| 3 Vrms 150 kHz to 80 MHz | d=4.5 \sqrt{P} 
(a) 0.78 Vrms : 150 – 250 kHz 
(b) 3 Vrms : 0.25 – 35 MHz 
(c) 1 Vrms : 35 – 80 MHz | d=1.2 \sqrt{P} 
\(d=3.5 \sqrt{P}\) |

<table>
<thead>
<tr>
<th>Radiated RF Electromagnetic Fields EN 61000-4-3</th>
<th></th>
</tr>
</thead>
</table>
| 3 V/m 80 MHz to 2.5 GHz | d=23.3 \sqrt{P} : 80 MHz to 130 MHz 
(d) 7 \sqrt{P} : 130 MHz to 309 MHz 
(c) 3.5 \sqrt{P} : 309 MHz to 800 MHz 
(d) 7 \sqrt{P} : 800 MHz to 2.5 GHz | Note: using unshielded input leads (d) |

where \(P\) is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer and \(d\) is the recommended separation distance in metres (m).

Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey (a), should be less than the compliance level in each frequency range (b).

Interference may occur in the vicinity of equipment marked with the following symbol:
NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

(a) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the Lifelines iEEG is used exceeds the applicable RF compliance level above, the Lifelines iEEG should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the Lifelines iEEG.

(b) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

(c) The immunity levels for conducted RF are for unscreened input electrode leads 1 m in length and worse-case coupling, including any resonances across the frequency band. The interference is less when the coupling plane of the interference source is not in the same plane as the electrode leads.

(d) The immunity levels for radiated RF are for unscreened input electrode leads 1 m in length and worse-case coupling, including any resonances across the frequency band. The interference is less when the polarisation plane of the interference source is not in the same plane as the electrode leads.

---

### Recommended separation distances between portable and mobile RF communications equipment and the Lifelines iEEG system

The Lifelines iEEG system is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the Lifelines iEEG system can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the Lifelines iEEG system as recommended below, according to the maximum output power of the communications equipment.

<table>
<thead>
<tr>
<th>Rated maximum output power of transmitter</th>
<th>Separation distance according to frequency of transmitter (m)</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>150 kHz to 80 MHz d=1.2√P</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
</tr>
<tr>
<td>0.1</td>
<td>0.38</td>
</tr>
<tr>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td>10</td>
<td>3.8</td>
</tr>
<tr>
<td>100</td>
<td>12</td>
</tr>
</tbody>
</table>

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1. At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.
NOTE 2. These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects and people.

**Wi-Fi Parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wi-Fi standard</td>
<td>IEEE802.11b, 802.11g, 802.11n Draft</td>
</tr>
<tr>
<td>Frequency range</td>
<td>2.4 GHz ~ 2.4835 GHz</td>
</tr>
<tr>
<td>Communication bandwidth</td>
<td>Support 20/40 MHz</td>
</tr>
<tr>
<td>Protocols</td>
<td>802.11b: CCK, QPSK, BPSK; 802.11g/n: OFDM</td>
</tr>
<tr>
<td>802.11g/n: OFDM</td>
<td>64/128-bit WEP, WPA/WPA2, WPA-PSK/WPA2-PSK, WPS</td>
</tr>
<tr>
<td>Transmission rate</td>
<td>11b: 11Mbps, 11g: 54Mbps, 11n: 150Mbps</td>
</tr>
<tr>
<td>Transmit Output Power</td>
<td>11b: 17±1.5dBm @ 11Mbps</td>
</tr>
<tr>
<td></td>
<td>11g: 14±1.5dBm @ 54Mbps</td>
</tr>
<tr>
<td></td>
<td>11n: 12.5±1.5dBm</td>
</tr>
<tr>
<td>Transmission range</td>
<td>Outdoor: 200m, Indoor: 50m (depend on environment)</td>
</tr>
<tr>
<td>Wireless Standards</td>
<td>IEEE802.11b, 802.11g, 802.11n Draft</td>
</tr>
</tbody>
</table>

**WiEEG Model 100**

**Safety Characteristics**

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Degree of Protection Against Harmful Ingress of Water</td>
<td>Not protected (IPX0)</td>
</tr>
<tr>
<td>Type of Protection Against Electric Shock</td>
<td>Type BF</td>
</tr>
<tr>
<td>Degree of Safety of Application in Flammable Gas</td>
<td>The use of the system is not suitable in the presence of a flammable anesthetic mixture with air or with oxy gen or nitrous oxide. Operating the devices in such an environment may cause an explosion</td>
</tr>
<tr>
<td>Electromagnetic Compatibility</td>
<td>IEC/EN 60601-1-2: 2001: CISPR 11 Group 1, Class B</td>
</tr>
<tr>
<td>Mode of operation</td>
<td>Continuous</td>
</tr>
</tbody>
</table>
Electromagnetic Emissions

The WiEEG is intended for use in the electromagnetic environment specified below. The customer or the user of the WiEEG model 100 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Emissions Test</th>
<th>Compliance</th>
<th>Electromagnetic Environment Guidance</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF Emissions</td>
<td>Group 1</td>
<td>The WiEEG uses RF energy only for its internal function. Therefore, its RF emissions are very low and are not likely to cause any interference in nearby electronic equipment.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF Emissions</td>
<td>Class B</td>
<td>The WiEEG is suitable for use in all establishments, including domestic establishments and those directly connected to the public low-voltage power supply network that supplies buildings used for domestic purposes.</td>
</tr>
<tr>
<td>CISPR 11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Harmonic Emissions IEC 61000-3-2</td>
<td>Not applicable. Device is DC powered.</td>
<td></td>
</tr>
<tr>
<td>Voltage Fluctuations/ Flicker Emissions IEC 61000-3-3</td>
<td>Not applicable. Device is DC powered.</td>
<td></td>
</tr>
</tbody>
</table>

Electromagnetic Immunity

The equipment is intended for use in the electromagnetic environment specified below. The customer or the user of the Equipment should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity test</th>
<th>IEC 60601 test level</th>
<th>Compliance level</th>
<th>Electromagnetic environment</th>
</tr>
</thead>
</table>
| Electrostatic discharge (ESD) IEC 61000-4-2 | ±6 kV contact, ±8 kV air | ±6 kV contact, ±8 kV air | Floors should be wood, concrete or ceramic tile. If floors are covered with synthetic material, the relative humidity should be at least 30%.
|                                              |                      |                  |                             |
| Electrical fast transient/burst IEC 61000-4-4 | ±2 kV for power supply lines, ±1 kV for input/output lines | Not Applicable |                             |
|                                              |                      |                  |                             |
| Surge IEC 61000-4-5                          | ±1 kV line(s) to line(s), ±2 kV line(s) to earth | Not Applicable |                             |
Voltage dips, short interruptions and voltage variations on power supply input lines IEC 61000-4-11
UT = 240 Vac and 120Vac

<table>
<thead>
<tr>
<th>Voltage dip, short interruptions and voltage variations</th>
<th>Not Applicable</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;5 % UT (&gt;</td>
<td>5 % dip in UT) for 0.5 cycle</td>
</tr>
<tr>
<td>40 % UT (60 % dip UT) for 5 cycles</td>
<td></td>
</tr>
<tr>
<td>70 % UT (30 % dip UT) for 25 cycles</td>
<td></td>
</tr>
<tr>
<td>&lt;5 % UT (95 % dip UT)</td>
<td></td>
</tr>
</tbody>
</table>

**Power frequency**
(50 Hz/60 Hz)
magnetic field IEC 61000-4-8

<table>
<thead>
<tr>
<th>Power frequency</th>
<th>3 A/m</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 A/m</td>
<td></td>
</tr>
</tbody>
</table>

*Power frequency magnetic fields should be at levels characteristic of a typical location in a typical commercial/residential or hospital environment.*

**Guidance and Manufacturer’s Declaration — Electromagnetic Immunity**

The WEEG model 100 is intended for use in the electromagnetic environment specified below. The customer or the user of the WEEG model 100 should assure that it is used in such an environment.

<table>
<thead>
<tr>
<th>Immunity Test</th>
<th>IEC 60601 Test Level</th>
<th>Compliance Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>Conducted RF IEC 61000-4-6</td>
<td>3 Vrms 150 kHz - 80 MHz</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Radiated RF IEC 61000-4-3</td>
<td>3 V/m 80 MHz - 2.5 GHz</td>
<td>3 V/m 80 MHz - 2.5 GHz</td>
</tr>
</tbody>
</table>

**Electromagnetic Environment — Guidance**

Portable and mobile RF communications equipment should be used no closer to any part of the WEEG, including cables, than the recommended separation distance calculated from the equation applicable to the frequency of the transmitter. **Recommended separation distance**

\[
d = \left[\frac{3.5}{V_1}\right]^{\frac{1}{2}}
\]

\[
d = \left[\frac{3.5}{E_1}\right]^{\frac{1}{2}}
\]

80Mhz to 800Mhz

\[
d = \left[\frac{7}{E_1}\right]^{\frac{1}{2}}
\]

800Mhz to 2.5Ghz
Field strengths from fixed RF transmitters, as determined by an electromagnetic site survey, should be less than the compliance level in each frequency range.\(^b\)

Interference may occur in the vicinity of equipment marked with the following symbol:

\[\text{\includegraphics[width=0.1\textwidth]{radio_signal_icon}}\]

**NOTE 1**—At 80 MHz and 800 MHz, the higher frequency range applies.

**NOTE 2**—These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects, and people.

\(a\) Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur radio, AM and FM radio broadcast, and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the location in which the WiEEG 100 is used exceeds the applicable RF compliance level above, the WiEEG 100 should be observed to verify normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the iEEG 100.

\(b\) Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

### Recommended Separation Distances

#### Recommended Separation Distances Between Portable and Mobile RF Communications Equipment and the WiEEG model 100

The WiEEG is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or the user of the WiEEG can help prevent electromagnetic interference by maintaining a minimum distance between portable and mobile RF communications equipment (transmitters) and the WiEEG as recommended below, according to the maximum output power of the communications equipment.

#### | Rated Maximum Output Power of Transmitter (W) | Separation Distance According to Frequency of Transmitter (m) |
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>150 kHz to 80 MHz</td>
<td>80 MHz to 800 MHz</td>
</tr>
<tr>
<td>(\frac{3.5}{V_1}\sqrt{P})</td>
<td>(\frac{3.5}{E_1}\sqrt{P})</td>
<td>(\frac{7}{E_1}\sqrt{P})</td>
</tr>
<tr>
<td>0.01</td>
<td>0.12</td>
<td>0.12</td>
</tr>
<tr>
<td>0.1</td>
<td>0.37</td>
<td>0.37</td>
</tr>
<tr>
<td>1</td>
<td>1.17</td>
<td>1.17</td>
</tr>
<tr>
<td>10</td>
<td>3.69</td>
<td>3.69</td>
</tr>
<tr>
<td>100</td>
<td>11.7</td>
<td>11.7</td>
</tr>
</tbody>
</table>
For transmitters rated at a maximum output power not listed above, the recommended separation distance $d$ in meters (m) can be estimated using the equation applicable to the frequency of the transmitter, where $P$ is the maximum output power rating of the transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1—At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2—These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from structures, objects, and people.